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Important User Information

Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to 
familiarize themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, 
and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required 
to be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the 
use or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or 
liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or 
software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, 
Inc., is prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.

Allen-Bradley, CompactLogix, ControlLogix, E300, FactoryTalk, Integrated Architecture, Logix5000, PlantPAx, PowerFlex, Rockwell Automation, Rockwell Software, RSLinx, SMC-50, SMT, Stratix, Studio 5000 Architect 
and Studio 5000 Logix Designer are trademarks of Rockwell Automation, Inc.

ControlNet, DeviceNet, and EtherNet/IP are trademarks of ODVA, Inc. Trademarks not belonging to Rockwell Automation are property of their respective companies.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous 
voltage may be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may 
reach dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to 
potential Arc Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL 
Regulatory requirements for safe work practices and for Personal Protective Equipment (PPE).
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Preface

The PlantPAx® system provides a modern approach to distributed control using 
common technology (integrated architecture) shared with all other automation 
disciplines within the plant. This approach creates a seamless information flow 
across the plant to create optimization opportunities and enables a connected 
enterprise.

Our scalable platform provides you with the flexibility to implement a
system appropriate for your application. Figure 1 shows the documents
(this manual in the highlighted section) that are available to help design and 
implement your system requirements.

Figure 1 - PlantPAx System Implementation and Documentation Strategy

• Define and Procure – Helps you understand the elements of the 
PlantPAx system to make sure that you buy the proper components.

• Build– Provides direction on how to implement the PlantPAx system 
architecture to help develop your application. 

• Prep– Provides guidance on how to get started and learn the best practices 
to develop your application. 

• Develop Specific Application – Describes the actions and
libraries necessary to construct your application that resides on the 
PlantPAx system.

Purpose of the User Manual

This document describes the steps necessary to start development of your 
PlantPAx DCS. We suggest that you perform the tasks in the order that is 
outlined in each chapter. However, each task has standalone screen facsimiles and
step-by-step procedures to let you skip to other chapters if necessary.

Each chapter has a flowchart that summaries the topics, similar to a mini 
Table of Contents.

See page 8 for manual conventions.

START:
Requirements

Define and
Procure Build Prep

Develop
Specific

Application

END:
Completed 

System

46297

• Infrastructure User Manual
PROCES-UM001

• Selection Guide
PROCES-SG001

• Virtualization User Manual
9528-UM001

• Reference Manual
PROCES-RM001

• Application User Manual
PROCES-UM003

• Library of Process Objects
PROCES-RM002

• Reference Manual
PROCES-RM001

http://literature.rockwellautomation.com/idc/groups/literature/documents/sg/proces-sg001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/sg/proces-sg001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/sg/proces-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/sg/proces-um003_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm002_-en-p.pdf


Preface
Manual Conventions For instructional purposes, this manual uses visual tools to complement the 
procedures. Icons that represent system elements are shown at the start of a 
section to help identify the system element that is being configured. The 
abbreviation for the element is listed with the icon for identification as shown in
the example.

See Table 1 for descriptions and abbreviations of the system element icons.

Use a domain controller 
with these procedures.

PASS01

System Element Icon

System Element Identifier (see Table 1) 

System Element Description

Table 1 - Visual Naming Conventions

Icon Description Abbreviation Element Names Topic Page

Logix controllers • LGXC01 - Controller
• LGXC02 - Controller

20,23, 26, 39, 43, 47, 
50, 79, 119, 123, 150, 
155, 158, 211, 211

PlantPAx workstations • OWS01(1) - Operator workstation
• EWS01(1) - Engineering workstation

45, 65, 183, 211, 212

PlantPAx Application servers • ASIS01 - AppServ-Info SQL server
• ASIH01 - AppServ-Info Historian server
• ASIV01 - AppServ-Info VantagePoint server
• ASAM01 - AppServ-Asset Management server
• ASBM01 - AppServ-Batch server
• ASEWS01 - AppServ-Engineering Workstation server 
• ASOWS01 - AppServ-Operator Workstation server

55, 59, 95, 183, 198, 
199202, 205

PASS
(Process Automation System Server)

• PASS01 - FactoryTalk® Directory
• PASS02A- Primary HMI server
• PASS02B - Secondary HMI server

59, 209, 216

(1) EWS and OWS are used throughout the manual but the same procedures apply for AppServ-EWS and AppServ-OWS.
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Preface
Action Identifier

Dialog boxes have red boxes to identify areas that require some type of user 
action, such as to type text or click ‘Next’.

Configure Programs Menu We strongly suggest that you perform the following procedure in the system 
computers to group folders under ‘Programs’ on the taskbar. When complete, you 

access Windows and software folders by clicking the Programs  symbol. 

1. Click the Windows  symbol.

2. Click Control Panel and choose Folder Options.

The Folder Options dialog box appears.
Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016 9



Preface
3. On the View Tab, select ‘Show hidden files, folders, and drives’
and click OK.

4. Right-click in the taskbar, click Toolbars, and choose New Toolbar.

5. On the New Toolbar window, designate a path for your Programs folder.

For example: 
C:\ProgramData\Microsoft\Windows\StartMenu\Programs.

6. Click Select Folder.
10 Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016



Preface
Additional Resources These documents contain additional information that concern related products 
from Rockwell Automation.

You can view or download publications at
http:/www.rockwellautomation.com/literature/. To order paper copies of 
technical documentation, contact your local Allen-Bradley distributor or 
Rockwell Automation sales representative.

Resource Description

PlantPAx Distributed Control System Infrastructure 
Configuration User Manual, publication PROCES-UM001

Describes procedures for how to configure system 
components that comprise a PlantPAx modern DCS.

PlantPAx Distributed Control System Selection Guide, 
publication PROCES-SG001

Provides basic definitions of system elements and sizing 
guidelines for procuring a PlantPAx system.

PlantPAx Distributed Control System Reference Manual, 
publication PROCES-RM001

Provides characterized recommendations for 
implementing your PlantPAx system.

Rockwell Automation Library of Process Objects Reference 
Manual, publication PROCES-RM002

Provides an overview of the code objects, display 
elements, and faceplates that comprise the Rockwell 
Automation Library of Process Objects.

Rockwell Automation Library of Logix Diagnostic Objects 
Reference Manual, publication PROCES-RM003

Provides information on Add-On Instructions that 
monitor Logix controllers to diagnose issues that 
include memory usage, communication, and control.

ControlLogix® HART Analog I/O Modules User Manual, 
publication 1756-UM533

Describes how to install, configure, and troubleshoot 
ControlLogix HART analog I/O modules.

ControlLogix Digital I/O Modules User Manual,
publication 1756-UM058

Describes how to install, configure, and troubleshoot 
your ControlLogix digital I/O modules.

ControlLogix Low-speed Counter Module User Manual, 
publication 1756-UM536

Describes how to install, configure, and use the counter 
module for counting incoming pulses.

Logix5000™ Produced and Consumed Tags Programming 
Manual, publication 1756-PM011

Details how to produce and consume system-shared 
tags by using a Logix5000 controller. 

PowerFlex® 750-series AC Drives Programming Manual,
publication 750-PM001

Describes how to install, start-up, and troubleshoot 
adjustable frequency AC drives.

PowerFlex 520-series Adjustable Frequency AC Drive User 
Manual, publication 520-UM001

Describes how to install, start-up, and troubleshoot the 
adjustable frequency AC drive.

SMC™-50 solid-state Smart Motor Controller User Manual, 
publication 150-UM011

Describes how to install, operate, and troubleshoot the 
reduced voltage soft starter.

Bulletin 193/592 E300™ Electronic Overload Relay User 
Manual, publication 193-UM015

Describes the operation of overload protection.

Redundant I/O System User Manual,
publication 1715-UM001

Explains how to install and set up the 1715 Redundant
I/O system.

EtherNet/IP and ControlNet to FOUNDATION Fieldbus Linking 
Device User Manual, publication 1788-UM057

Describes the installation and operation of the
1788-EN2FFR and 1788-CN2FFR linking devices.

EtherNet/IP and ControlNet to PROFIBUS PA Linking Device 
User Manual, publication 1788-UM058

Describes the installation and operation of the
1788-EN2PAR and 1788-CN2PAR linking devices.

Stratix™ Managed Switches User Manual,
publication 1783-UM007

Describes the embedded software features and tools for 
configuring and managing Stratix managed switches.

Product Compatibility and Download Center at
http://www.rocZkwellautomation.com/
rockwellautomation/support/pcdc.page

Website helps you find product-related downloads 
including firmware, release notes, associated software, 
drivers, tools, and utilities.

Rockwell Automation Sample Code website
at http://samplecode.rockwellautomation.com 

Accesses a Rockwell Automation web page to search for 
sample code.
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Chapter 1

Configure Controllers and Process Strategies

Overview A traditional distributed control system (DCS) is built from purpose-built, 
proprietary hardware, and software that are optimized for process control. 
However, a traditional DCS is difficult to integrate with other necessary 
automation and business systems in the plant.

The PlantPAx® system leverages a more modern approach by using scalable,
multi-disciplined control technology to provide a common automation platform 
for seamless integration within a plant. This modern DCS approach provides 
improved workforce productivity, reduced total cost of ownership, and enables 
new opportunities for optimization to improve yields and reduce costs.

The performance and functionality of the 
PlantPAx system is dependent upon 
following the sizing guidelines and 
application rules to create a system that is 
optimized for process control. System 
performance rules and guidelines are developed through a process called 
characterization. Characterization is the activity of measuring system 
performance against key operational criteria called critical system attributes 
(CSA). CSAs provide specific recommendations regarding application sizing and 
system performance. 

Follow the instructions in this manual to build your control system with the 
highest level of functionality as prescribed by the PlantPAx System Reference 
Manual and characterization. For example, the procedures in this chapter 
describe the Studio 5000 Architect™ application that helps reduce the 
engineering time to assemble your integrated architecture and process 
application. A canvas area within the Architect application lets you configure 
system elements by using FactoryTalk® View software and the Studio 5000 Logix 
Designer® application.

This chapter also explains how to add process strategies to controllers. The 
strategies, which are labeled ‘PS_’ (process strategies) in a PlantPAx application, 
are pre-connected objects for control of process devices. The objects are 
incorporated from the Rockwell Automation® Library of Process Objects.
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Considerations Consider the following suggestions before starting this chapter:
• The Architect application must be installed on an

Engineering workstation.

• Check for the latest version of the Process Library in the Product 
Compatibility and Download Center (PCDC) before initiating an 
Architect project.

• We recommend that you perform all I/O configuration inside the
Logix Designer application.

Figure 2 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 2 - Studio 5000 Architect Workflow

TIP You can access the PCDC from the Architect application. See page 16 
for details.

Start

Use a Project in Architect

page 15

Organize Your Controller Folders

page 20

Multi-controller CommunicationSee Chapter 2

Build Process Strategies

page 26

Sync Controller to System

page 39

• Controller Organizer
• Logical Organizer

• PS_AIn_Chan
• PS_PID_AIn_Chan
• PS_PF755
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Use a Project in Architect This section describes how to use the software tools within the Architect 
application to add and modify elements to an existing project. FactoryTalk View 
software and the Studio 5000 Logix Designer application are available in the 
Architect application. 

For a description of the Architect palette, complete these steps.

1. To open the Studio 5000 Architect application, click the Programs  
symbol and choose Rockwell Software>Studio 5000.

The Studio 5000® Common Launcher appears.

2. Open a PlantPAx project.

To create a project, see the PlantPAx Distributed Control
System Infrastructure Configuration User Manual,
publication PROCES-UM001.

IMPORTANT Procedures in this chapter assume that you have completed the following:
• Selected a template
• Created a controller name
• Synchronized the project
For procedures on the bulleted items, see Chapter 6 in the PlantPAx
Distributed Control System Infrastructure Configuration User Manual,
publication PROCES-UM001.

Use an Engineering Workstation
with these procedures.

EWS
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Chapter 1 Configure Controllers and Process Strategies
Wait a few minutes while the ACD files and project data load.

The Architect canvas appears with a wire diagram of the application 
hardware for your project.

1 2

3

4

5 6

7

Table 2 - Studio 5000 Architect Palette Example

Name Graphic Example Description

1 - Project Explorer In the upper, left corner, the Project Explorer lists the Logix Designer and 
FactoryTalk View projects that comprise the Studio 5000 Architect Application. 
IMPORTANT: When you are in the Project Explorer, you are using the Architect 
application. You must open a project in the Explorer to access the Studio 5000 
Logix Designer application. To avoid confusion, the words ‘Architect’ and
‘Logix Designer’ are in the respective ribbon headers.

The system template that you select contains a number of controller and 
FactoryTalk View projects. Typically, there are more projects (than shown in the 
graphic example) that are contained in the Project Explorer as your system 
develops over time.

There is one FactoryTalk View software project titled ‘PlantPAx’. The three 
projects that are contained in the template are View ME, View SE Distributed, 
and View SE Station Local.

The Hardware Diagrams folder contains the components on the canvas that 
represent your PlantPAx system. See number 4 for more information on
the canvas.
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2 - Library Management In the upper, right corner, you can view hardware (switches, controllers, 
associated I/O modules, and so forth) in the project. 
There are two libraries that are listed as ‘Read Only’ to denote they cannot be 
modified or managed within Architect. 
User-defined libraries are supported in Architect. You must download the 
Rockwell Automation Library of Process Objects from the Product Compatibility 
and Download Center (PCDC). See 6 - PCDC.

3 - Communication In the lower, left corner, the Communications pod shows the communication 
path from the PASS01 computer to the five controllers. These paths are
pre-defined shortcuts by using the Single Process Server template.

4 - Canvas In the middle section, the canvas shows a graphical representation of the system 
elements that comprise the application. You can drag-and-drop elements to 
modify a project.

The canvas also provides access to the PlantPAx System Selection Guide and the 
Product Compatibility and Download Center (PCDC). See 5 - Selection Guide and 
6 - PCDC table descriptions.

5 - Selection Guide In the upper, left corner of the canvas, click 
the PlantPAx logo. Adobe Reader opens with 
the license terms. 
Click Accept to access the Selection Guide for 
system procurement guidelines.

Table 2 - Studio 5000 Architect Palette Example

Name Graphic Example Description
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Download Process Strategies

To use Process Strategies in your project, you must download the Process Library 
Version 3.5 or later from the PCDC web site. The Process Strategies.exe file is in 
the Files folder of the Process Library download. 

Complete these steps.

1. See 6 - PCDC in Table 2 to access the web page.
The Process Library appears in a list.

2. Click Process Library to select a version from the Selections tab.

3. Click Downloads to select the desired version.

4. Click the Show Downloads  icon.

5. In the Downloads list, click RA Library of Process Objects.

6. Click the Download Cart and then click Download Now.

You need a user name and password to download files.

7. Read the software license agreement and click Accept.

8. Click Managed Download.

9. Click Run.

The Download Manager opens.

6 - PCDC In the upper, right corner of the canvas, 
click the Rockwell Automation logo. The 
Library filter appears to let you download 
the Process Library from the Product 
Compatibility and Download (PCDC) 
website. The PCDC web site provides access to the latest software and
hardware updates.

For procedures on how to use the PCDC, see Chapter 4 in the PlantPAx System 
Infrastructure Configuration User Manual, publication PROCES-UM001.

See Download Process Strategies for how to access the .exe file from the Process 
Library download.

7 - Messages At the bottom of the canvas, the Messages area provides alerts, if any, for
the project.

Table 2 - Studio 5000 Architect Palette Example

Name Graphic Example Description
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A progress bar shows the installer path to the download folder.

10. Click Open underneath the progress bar (next to the download
folder path).

11. Extract the Process Library zip files to the working directory.

12. Double-click the Files folder.

13. Double-click the Process Strategies folder.

14. Double-click the Process Strategies.exe file.

A WinZip dialog box appears to unzip the Process Strategies.exe file.

15. Click Browse (ellipsis ‘…’) to find the Process Strategies folder with the 
process strategies for this project within the Architect application.

16. Click OK to choose the folder and then click Unzip.

17. Click OK.
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Organize Your Controller 
Folders

This section shows how to configure your controller folders by using the 
following tabs in the Logix Designer application:

• Controller Organizer — Lists the execution tasks and I/O configuration
• Logical Organizer — Sorts in terms of procedures, objects, functions, 

equipment, or some other natural term or concept for a ‘logical’ model of 
your application.

Controller Organizer

Complete these steps.

1. In Studio 5000 Architect, right-click a controller and choose Open Project 
in Designer.

IMPORTANT Before setting up system folders, we recommend that you review the controller 
guidelines in the PlantPAx Reference Manual, publication PROCES-RM001.
20 Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016

http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/proces-rm001_-en-p.pdf


Configure Controllers and Process Strategies Chapter 1
The execution tasks appear in the Controller Organizer tab. Periodic tasks 
are executed at specific rates that are based on application requirements

Tasks
See Tip

TIP The controller template 
contains nine predefined 
periodic tasks, eight of 
these named Tasks A…H. 
There is a separate periodic 
task that is named 
Controller Status, which is 
used to collect system 
diagnostics. For example, 
the L_CPU Add-On Instruction monitors resources.
Each task is set to execute at a defined time interval from
50 ms…10 s, with faster tasks getting higher priority.
See the Task Configuration guidelines in the PlantPAx Reference 
Manual, publication PROCES-RM001.
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Chapter 1 Configure Controllers and Process Strategies
2. To create a program, right-click a task and choose Add>New Program.

The New Program dialog box appears.

3. Type a program name (Area01 is the example) and click OK.

4. To create a routine within a program, right-click the name of the program 
that you created.

5. Click Add and choose New Routine.

A Jump to Subroutine ( JSR) is going to be added to the program to 
execute a command. JSRs are explained later in this section.
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6. Type ‘MainJSR’ for the routine name and click OK.

Logical Organizer

Complete these steps in the Logical Organizer to create an organizational model 
of our system.

1. From the controller that is being configured, click the Logical
Organizer tab.

2. Right-click the controller and choose Add>New Folder.

The New Program dialog box appears.

3. Type ‘System’ for the folder name and click OK.

Logical Organizer
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The folder appears in the Logical Model list for the controller.

4. Drag-and-drop the Diagnostics folder and all Task programs into the 
‘System’ folder. 

5. Right-click the controller and choose Add>New Folder.

6. Type a folder name and click OK.

TIP  A Diagnostics task is included in all controller templates to provide for 
troubleshooting, reporting, and alarming of controller status
and resources.
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7. Drag-and-drop the folder (Area01) into the program (Process01) folder. 

The controller folders are ready to Build Process Strategies on page 26.
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Build Process Strategies This section describes how to add process strategies to controllers. The strategies, 
which are labeled ‘PS_’, contain pre-connected Process Library objects for 
control of process devices. Strategies are imported as Function Block routines
or Ladder Logic rung imports to help reduce implementation time of
your application.

Figure 3 - Process Strategy Example Using the P_PIDE Object

The following procedures do not encompass all available process strategies. The 
examples that are shown are a cross-section of the Rockwell Automation Library 
of Process Objects that comprise the process strategies.

Program parameters are used for I/O connection. The Add-On Instruction tags 
are controller-scoped tags.

PS_AIn_Chan

The PS_AIn_Chan strategy lets you monitor a basic analog object with
channel capability.

1. From the Studio Architect application, right-click a controller that is being 
configured and select Open Project in Designer.

The Logix Designer application opens within the Architect tool.

2. Click the  tab.

IMPORTANT To complete the procedures in the section, you must have unzipped the process 
strategies folder within the Process Library download. See page 18.
The procedures are written as if they are being performed online. However, if 
you are offline, the procedures can also be used because they are similar.
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3. Right-click the program (Area01 is the example) and choose
Add>Import Routine.

The Import Routine dialog box appears.

4. Browse the path to the Process Strategies folder and select the
(RA-LIB)PS_AIn_Chan_3_5-00_ROUTINE.L5X.

5. Click Open.

TIP See page 19 for the path to the folder that you used to unzip the 
process strategies folder.
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The Import Configuration dialog box appears.

6. Click the Find/Replace button to find all tag references of ‘XT101’ and 
replace with a user-designated tag name.

Our example is ‘TT01001’.

7. Click Replace All.

Verify that the Final Name and 
Description boxes are checked.

IMPORTANT In the Find Within section at the bottom of the dialog box, the
Final Name box defaults with a check mark only. The first time that
you use this dialog box, you must check the Description box. 
Thereafter, the Description box defaults with a check mark.

TIP Click Close to exit Find/Replace only if you are done using the utility.
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8. Repeat step 6 and step 7 to find all tag references to ‘TagDescript’ and 
replace with a description.

Our example is ‘Temperature 01001’.

9. Click Close to exit Find/Replace.

10. Click Tags to view all parameters that comprise the PS_AIn_Chan 
strategy.

.

11. Click OK.

TIP If there are errors, a red ‘X’ with a message appears to define the issue.
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12. Select Import Logic Edits as Pending and click OK.

If offline, the imported values are written to the project.

Add JSR Instructions

Our program includes a Jump to Subroutine ( JSR) instruction that we added
on page 23. The instruction directs the controller to ‘jump to’ and execute a 
separate subroutine file within the ladder program and return to the instruction 
following the JSR instruction.

We use JSR instructions to schedule the routines that are added for execution. A 
JSR instruction must be created for each routine.

1. From the Logical Organizer in the Logix Designer application,
double-click MainJSR.

IMPORTANT You must be online to view the dialog box for the next procedure.
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A JSR instruction can be added in the following ways:
• From the Program Control tab, click JSR (as shown in the example). 

(Click the left (<) and right (>) arrows to find the Program
Control tab.)

• Click the rung and type ‘JSR’. Double-click the routine name and select 
the created Process Strategy. (See the next example on page 31.)

2. If online, click the Finalize All Edits in Program  icon.
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3. Click Yes.

The control strategy (PS_AInChan in our example) appears in the
Logix Designer application.

4. Save the Logix Designer project.
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PS_PID_AIn_Chan

The PS_PID_AIn_Chan strategy provides loop control with an analog object 
that has channel capability.

1. Repeat steps 1 through 3 on page 26 and page 27.

2. On the Import Routine dialog box, browse the path to the
Process Strategies folder and select 
(RA-LIB)PS_PID_AIn_Chan_3_5-00.ROUTINE.L5X.

3. Click Open.

The Import Configuration dialog box appears.

4. Click the Find/Replace button to find all tag references to ‘XIC502’ and 
replace with a user-designated tag name.

Our example is ‘FIC01002’.

5. Click Replace All.

TIP The procedures and screen facsimiles to create this instruction are similar to 
PS_AIn_Chan. For your convenience, we include the screen facsimiles that 
require specific information for this instruction.

TIP Click Close to exit Find/Replace only if you are done using the utility.
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6. Repeat step 4 and step 5 to find all tag references to ‘TagDescript’ and 
replace with a description.

Our example is ‘Flow Control 01002’.

7. Click Find Next for all tag references to ‘XT502’ and replace with a
user-designated tag name.

Our example is ‘FT01002’.

8. Click Replace All.
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9. Repeat step 4 and step 5 to find all tag references to ‘TagDescript’ and 
replace with a description.

Our example is ‘Flow 01002’.

10. Click Close to exit Find/Replace.

11. Click Tags to view all parameters that comprise the P_PID_AIn_Chan 
code object.

12. Click OK.

13. If online, select Import Logic Edits as Pending and click OK.

If offline, the imported values are written to the project.
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14. Complete the MainJSR routine procedures as documented on page 30.

15. Save the Logix Designer project.

PS_PF755

The PS_PF755 strategy provides a PowerFlex® drive interface.

1. Repeat steps 1 through 3 on page 26 and page 27.

2. On the Import Routine dialog box, browse the path to the
Process Strategies folder and select 
(RA-LIB)PS_PF755_3_5-00.ROUTINE.L5X.

3. Click Open.

TIP The procedures and screen facsimiles to create this instruction are similar to 
PS_AIn_Chan. For your convenience, we include the screen facsimiles that 
require specific information for this instruction.
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The Import Configuration dialog box appears.

4. Click the Find/Replace button to find all tag references to ‘MT310’ and 
replace with a user-designated tag name.

Our example is ‘MT01001’.

5. Click Replace All and then OK.

6. Repeat step 4 and step 5 to find all tag references to ‘TagDescript’ and 
replace with a description.

Our example is ‘Motor 01001’.

7. Click Tags to view all parameters that comprise the PS_PF755 
strategy.

TIP If there are errors, a red ‘X’ with a message appears to define the issue.
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8. Click OK.

9. If online, select Import Logic Edits as Pending and click OK.

If offline, the imported values are written to the project.

10. Complete the MainJSR routine procedures as documented on page 30.

11. Save the Logix Designer project.
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Sync Controller to System Complete these steps to synchronize the controller changes with the system 
template inside the Studio Architect software.

1. From the Studio 5000 Architect application, right-click a controller that is 
being configured and choose Synchronize Project.

The Synchronize Summary window appears.

The example shows the project that is expanded with the list of changes.

2. Click OK.

The Ethernet Configuration dialog box appears.

3. Leave the devices and their port configuration as is, and click OK.

A wait message appears while the project is being synchronized.
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To verify that the changes are synchronized with the system, complete these steps.

1. From the Studio 5000 Architect application, right-click a controller 
strategy and chose Open Routine.

In the Logix Designer application, the program logic appears for the 
selected process strategy.
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2. From the Studio 5000 Architect toolbar, click the binoculars to find 
information.

3. From the Find text box, type the tag name.

4. Click Start Search.

This feature provides search capability for the entire system.
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The tags for the selected routine display underneath the system model on 
the Studio Architect software.
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Chapter 2

Configure Controller-to-Controller 
Communication

This chapter describes how to establish a communication pipeline between 
controllers by creating produce/consume tags with a user-defined data
type (UDT). 

A Logix5000™ controller lets you produce and consume system-shared tags. A 
producer controller sends data to the system. The consumer controller is 
configured to consume the produced tag. The data type of the consumed tag 
must match the data type of the produced tag.

For controllers to share produced or consumed tags, the controllers must be 
attached to the same network, such as a ControlNet or EtherNet/IP network. 

The consumed tags require connections. As you increase the number of 
controllers that can consume a produced tag, you also reduce the number of 
connections the controller has available for other operations, like communication 
and I/O. 

Considerations Consider the following suggestions before starting this chapter:
• Producer/Consumer uses Class 1 communication (I/O) to enhance

data integrity and response time.
• The Producer/Consumer configuration is available only in offline mode. 

During the initial system configuration, we recommend that you create the 
communication between all system controllers.

• If a controller is not consuming the produced tag, we recommend that you 
inhibit the controller connection to save bandwidth.

LGXC01

Produced Tag LGXC01
Consumed Tag LGXC02

LGXC02

Consumed Tag LGXC01
Produced Tag LGXC02
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Figure 4 shows the topics that are described in this section. Click or see the page 
number for quick access to a section.

Figure 4 - Controller-to-Controller Workflow

See Chapter 3

Start

Create Produce/Consume Tags

See page 50

Configure an HMI Project

Create Produce/Consume Data Type

See page 45

Create Controller Network

See page 47
44 Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016



Configure Controller-to-Controller Communication Chapter 2
Create Produce/Consume 
Data Type

Complete these steps to create user-defined data type (UDT). Remember, the 
data type of the consumed tag must match the data type of the produced tag.

1. In the Controller Organizer of the Logix Designer application, click ‘+’ to 
expand the Data Types folder for the producer controller.

2. Right-click User-Defined and choose New Data Type.

The New UDT dialog box appears.

3. To add members to your new data type, do the following:
a. Type a name. 

Our example is PC_UDT.
b. Click Add Member and type a name and data type.
c. Repeat step b for each new member of the UDT.
d. Click OK.

4. Save your work.

5. Synchronize your work in the Architect project.

Use an Engineering Workstation
with these procedures.

EWS

IMPORTANT The Consumer controller must use the Connection Status for the source 
quality of the information. If there is a loss of communication, the 
Connection Status reports the fault.
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In the Architect project, the UDT that you created appears in the
User-Defined list for the controller.

6. Drag-and-drop the new UDT into the other controller.

The UDT is now in the User-Defined list for the other controller.
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Create Controller Network This section describes how to add controllers and place the Producer controller 
definition into the Consumer controller. This action creates a network 
communication path.

Complete these steps.

1. On the Architect canvas, click and drag the adapter of the Producer 
controller and drop into the Consumer controller.

For our example, LGXC02 is the Producer controller and LGXC01 is
the Consumer.

IMPORTANT To modify controller properties and add local communication adapters,
see the PlantPAx® System Infrastructure Configuration User Manual,
publication PROCES-UM001. 

Adapter
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2. Use the defaults and click OK.

If necessary, you can change the IP address and then click OK.

3. On the Architect canvas, click and drag the controller for the Producer 
controller and drop into the Consumer controller.

Controller
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4. Use the defaults and click OK.

5. Repeat step 1 through step 4 but with LGXC01 as the Producer controller 
and LGXC02 as the Consumer.

The respective controllers are now linked and can communicate.

6. Save your work.
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Create Produce/Consume 
Tags

Complete these steps to attach produce/consume tags to a UDT for an
application controller.

1. In the Architect menu bar, click View and choose Produce/Consume Tags.

2. In the Produce/Consume Tags window, click Add.

IMPORTANT Step 1 applies if you do not have Produce/Consume tabs on the
bottom of the Architect application. Otherwise, click an existing 
Produce/Consume tab.
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The Consumer Tag dialog box appears.

3. Select ‘LGXC01’ in the Controller text box.

4. Type ‘LGXC02’ as the tag name.

5. Select PC_UDT from the Data Type pull-down menu.

The message ‘Producer tag must be defined’ appears.

6. Click Connection.
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The Producer Tag dialog box appears.

Make sure that the Producer controller is listed.

7. Set an RPI value and click OK.

Use the highest permissible RPI for your application. Follow the standard 
rule, which is, the RPI must be two times faster than the execution.
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The Consumer Tag dialog box reappears.

Observe in the Information box that you are creating a consumed tag with 
the same UDT as a produced tag with your selected RPI.

8. Click OK.

9. Repeat step 1 through step 7 with ‘LGXC02’ as the Producer controller
and ‘LGXC01’ as the Consumer.

The created tags appear in the Produce/Consume Tags window.
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10. Right-click in each controller and choose Commit Project.

When online, the Monitor Tags tab lists the controller tags.

IMPORTANT Make sure that the Logix Designer application is closed before you 
Commit a project.
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Configure an HMI Project

This chapter describes how to create and configure your logical servers (data, 
human-machine interface (HMI), and alarms). All of these software components 
are assigned to a PASS server.

Use one of the templates that are described on page 57 to configure the servers 
within an Architect project.

See page 70 for examples of navigation features for your HMI project.

Considerations Before you complete tasks in this chapter, we suggest that you do the following:
• Determine the number of HMI, data, and alarm and event servers to be 

used where they are hosted
• Make sure that PASS servers are installed and available
• Identify the target screen resolution on your OWS to choose the 

appropriate HMI template
• All system server configurations are described in the PlantPAx®

Distributed Control System Infrastructure Configuration User
Manual, publication PROCES-UM001.

Application Servers
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Figure 5 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 5 - Server Workflow

Start

Configure Alarms

View and Modify HMI Objects

See page 73

Choose an HMI Template

See page 57

Create an OWS Client File

See page 65

Explore Template Features

See page 70

See Chapter 4

• Observe the Template Structure
• Configure an HMI Server
• Commit the Project

• Alarm Tools
• System Status
• Navigation Tools
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Choose an HMI Template Use the PlantPAx templates to create your HMI project to follow the PlantPAx 
system recommendations. There are several HMI templates available from the 
Product Compatibility and Download Center (PCDC).

Click http://www.rockwellautomation.com/rockwellautomation/support/
downloads.page to access the PCDC.

For most systems, you load the templates on the PASS server by using the EWS, 
and your system data is viewed on the OWS.

The templates include the following attributes:
• Basic display layout
• Navigation
• FactoryTalk® View Alarm and Event displays

See page 58 for a description of the template structure.

Table 3 - HMI Template Names and Display Resolutions

Name Supported Resolution

FTVSE_8_1_P1FHD_3_5_01.apa 1920 x 1080, Full HD

FTVSE_7_P1WXGA_3_5_01.apa 1366 x 768, WXGA

FTVSE_7_P1FHD_3_0_00.apa 1920 x 1080, Full HD

FTVSE_7_P1SXGA_3_0_00.apa 1280 x 1024, SXGA
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Observe the Template Structure

The example tree diagram 
shows the HMI template 
structure. Display and 
start-up macros are created 
as part of the template 
(shown at the bottom of 
the example).

The displays that are 
included in the template 
have the following naming 
structure:

• (FRAME) is a 
prefix that is used 
on items that are 
intended only to be 
used as is with 
minimum 
customization.

• P1f is a unique 
template identifier. 
This prefix 
identifies the 
template that is 
being applied and 
the files that are 
part of the template.

• Template is used to identify a template that can be copied multiple times 
to create application-specific content. If the word 'Template' is omitted, 
the file is not a template display.

• The rest of the name is a brief description of the display file. We suggest 
that these names be similar across templates. For example, P1 Home is the 
initial display. 

Macros configure the initial display structure during runtime. The start-up 
macros open the framework files in the orientation intended. For example, the 
header display at the top and the footer display at the bottom.

FRAME

P1

Macros
58 Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016



Configure an HMI Project Chapter 3
Configure an HMI Server

Complete these steps to build your HMI objects and displays through 
drag-and-drop procedures in an Architect project.

1. To add the basic frame for the template, drag the Libraries>
Process Library>Templates>FactoryTalk View SE>P1f Template from the 
Library Management pane and drop it into the PlantPAx HMI folder. 

IMPORTANT If you are not using the Rockwell Automation® Library of Process 
Objects, skip the next steps.
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2. In the Library Management pane, expand Libaries>Process 
Library>Common folders.

3. Expand the FactoryTalk View SE folder and drag-and-drop into the 
PlantPAx HMI folder in the Project Explorer pane. 

The FactoryTalk View SE folder contains the following common displays 
and objects for the Rockwell Automation Library of Process Objects:
• Common-AnalogEdit
• P_Alarm
• P_Gate
• P_Mode

IMPORTANT The drag-and-drop option provides you with all global objects (.ggfx), 
images (.png), and macros (.mcr) for your project. The 
Common-AnalogEdit, P_Alarm, P_Gate, and P_Mode displays (.gfx) 
are also added to your project.
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4. In the Process Object folder, select the Object folder used in the 
application and drag-and-drop into the PlantPAx HMI folder.

5. Repeat step 4 for each object that you need for your process strategies.

6. Save your work.
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Commit the Project

This section describes how to commit a project. The Commit option sends the 
data from an Architect project to the FactoryTalk View project for the respective 
servers: HMI, data, and alarm.

Complete the following steps:

1. In the Project Explorer pane, right-click the application (PlantPAx in the 
example) and choose Commit Project. 
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2. Click OK and Close on each of the respective Commit dialog boxes to 
complete the configuration of the servers. 

3. To confirm the commit action, in the Project Explorer pane, right-click the 
application (PlantPAx in the example) and choose Open Project in 
Designer. 
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The FactoryTalk View Studio window appears.

4. In the Explorer pane, open the 
PlantPAx>Area>PlantPAxHMI>Graphics>Displays folder.

This folder typically contains the FRAME, P1f, and RA-BAS display files.

Proceed to page 65 to create a FactoryTalk View SE client file.
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Create an OWS Client File In this section, you create a FactoryTalk View SE client file. Client files are used 
to launch a FactoryTalk View software client from the Operator Workstation 
(OWS). Once created, this client file can be copied to each OWS. 

Complete the following steps.

1. Click the Programs  symbol and choose Rockwell 
Software®>FactoryTalk View>FactoryTalk View Site Edition client. 

2. To create a client file, click New. 

IMPORTANT Our procedure shows how to create the client file on an OWS. This procedure 
can also be used on an EWS.

Use an Engineering Workstation 
or Operator Workstation with 
these procedures

EWS or OWS
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3. Type the name of the new client file and click Next. 

4. Click Network Distributed or Network Station and click Next. 
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5. From the pull-down menu, choose the name of the application. 

6. Accept the rest of the defaults and click Next.

7. Use Browse (…) to navigate to and choose an Area (Area in the example).

8. From the Startup macro pull-down menu, choose a startup macro 
(P1f_client in the example).

The startup macro launches the initial displays and docks the navigation 
and alarm tool bars.

9. Click Next. 
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10. Check Maximize window and click Next.

Make sure your selections in the checkboxes match the dialog box 
as shown. 

11. From the FactoryTalk View SE Client Auto Logout dialog box, click Next.

12. Accept the default setting and click Finish. 
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When the client file opens, your application window appears with the 
layout of the selected template. 

Proceed to page 70 to learn about navigation features of your project.

Current Active Alarms Login/Logout Buttons Current User
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Explore Template Features This section shows display navigation for your HMI project. We suggest you 
familiarize yourself with these features to enhance productivity with your 
templates.

Alarm Tools

Click the bell icon to access active alarms. Tabs appear near the bottom-left of the 
window to access an alarm summary, alarm history, shelved alarms, and an 
alarm explorer. 

IMPORTANT Actual layout varies depending on the HMI template selection and the revision 
being applied.

Alarm Access

Display 
Navigation 
Map

Administrator

Repaint/Repair
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System Status

Click the System Status icon to view system diagnostic.

Navigation Tools

There are three quick screen navigation buttons: Previous, Next, and History. 

System Status

Previous/Next/History
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The Display Navigation Map icon  (at the bottom of the application 
window) lets you move around your application faster. This feature is typically 
used for applications that have more than 10 displays. Use the button bar 
(page 69) for fewer than 10 displays. 

The Administrator icon  accesses information about the system, including 
display element sizes, version numbers, and security codes. 

The View Security button  accesses the Current Security Access 
display that shows the security level of the current user. The security settings for a 
user cannot be changed from this view-only display. 
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The Repaint/Repair icon  can be used to make edits to an application. 
After a change is made, click the icon to refresh the application with the changes. 
This option can also be used to repaint the application if displays are not shown 
properly.

Proceed to View and Modify HMI Objects.

View and Modify HMI Objects Complete the following steps to modify HMI objects within an Architect 
product by using FactoryTalk View Studio software.

1. In the Project Explorer of a Studio Architect project, right-click an 
application (PlantPAx in the example) and choose 
Open Project in Designer. 

Wait a short time while the FactoryTalk View Studio software opens.

Notice that the project structure and content in FactoryTalk View Studio 
appears as it does in an Architect project.

2. Click to expand the Areas, HMI servers, and Displays under the 
Graphics folder.

Use an Engineering 
Workstation with these 
procedures

EWS01
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3. Double-click (FRAME) P1f Template Display and choose Duplicate.

A window appears with the selected template.

4. Rename the display (for example, Display screen 1) and click OK.

5. Open the renamed display.

6. Expand Global Objects and double-click (RA-BAS) P_AIn Graphics 
Library to open a collection of display elements for analog input objects. 
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7. Right-click an object and choose Copy.

8. Paste the object onto the renamed display.

9. Right-click the object and choose Global Object Parameter Values. 

The Global Object Parameter Values dialog box appears. 

10. Click Browse (ellipsis ‘…’) to select tags and click OK.

For details on how to configure global object parameter values, see 
Chapter 4 in the Rockwell Automation Library of Process Objects 
Reference Manual, publication PROCES-RM002.
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11. In the left pane of the Project Explorer under Global Objects,
click P1f HButtonbar

The button bar appears.

12. Double-click twice the Screen 1 button to open the Button Properties 
dialog box.

The renamed display (Display screen 1 in the example) is now associated 
with the Screen 1 button.

To change the name of the Screen 1 button, use the tools in the Up 
Appearance tab of the Button Properties dialog box.
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Configure Alarms

This chapter describes how to configure your process alarms on the
PlantPAx® system. 

Alarms are a critical function of a distributed control system. Effective alarm 
systems direct the operator’s attention to improve the productivity, safety, and 
environment of a process plant. Ineffective alarm systems have often been cited as 
contributors to major environmental and safety incidents. This has led to the 
development of industry standards that govern alarm management engineering 
practices and alarm system performance metrics.

This chapter does not cover the engineering practices required to fully apply 
alarm management standards. However, this chapter does cover the procedure 
required to implement alarms on the PlantPAx system to make sure of system 
performance and alignment with the functionality expectations of the
industry standards.

When a controller detects an alarm condition, the server publishes the 
information to a subscribing OWS via FactoryTalk Alarm and Event Services. 
This chapter includes how to configure visualization components, including an 
alarm summary, alarm log viewer, and alarm banner. 

IMPORTANT Install the Alarms Builder Tool to simplify alarm tag creation. Each alarm object 
that comprises the Library of Process Objects must be enabled to be created
by Alarms Builder.
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Figure 6 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 6 - Alarm Workflow

Start

Configure an Alarm Banner

See page 82

View an Alarm Summary

See page 87

Configure HistorianSee Chapter 5

Configure an Alarm Log Viewer

See page 89

View Alarm System Configuration

See page 92

Configure an Alarm Group

See page 79

Configure the Alarms Builder Tool by using the 
procedures in the Rockwell Automation® Library of 

Process Objects, publication PROCES-RM002

See Knowledgebase Answer ID 466418 at 
https://rockwellautomation.custhelp.com/ for more 

information on Alarm roll-up and filtering.

• Alarm Banner
• Alarm Sounds
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Considerations Consider the following suggestions before starting this chapter:
• Tag-based alarms are recommended to generate alarms in the PlantPAx 

system. Device-based alarms can be used, but we recommend that you 
limit their use to enhance system performance.

• Perform any alarm configurations in Chapter 8 of the PlantPAx
Distributed Control System Infrastructure Configuration
User Manual, publication PROCES-UM001.

• Review the HMI template information in Chapter 3.

Configure an Alarm Group This section describes how to configure a group of alarms for a specific area. 
Complete these steps for each group of alarms for each area.

The following example shows two controllers and each has two areas.
• Controller LGXC01 (in the Process01 folder) contains Area01 

and Area02.
• Controller LGXC02 (in the Process02 folder) contains Area03 

and Area04.
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1. Use Alarms Builder to import your alarms as documented in
Appendix B of the Rockwell Automation Library of Process Objects 
Reference Manual, publication PROCES-RM002. 

IMPORTANT When using Alarms Builder, it is expected that the Process Tree is 
created. To create the group organization, you must create the
display association.
We recommend that you create an entire system organization by 
attaching multiple controllers, different programs, routines, and 
so forth. These items can be part of one group to be the foundation of 
the alarm grouping.
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2. In the FactoryTalk View Studio software, open 
PlantPAx>Area>Alarm>PlantPAx_AE>Alarm and Event Setup. 

The Alarm and Event Setup window appears. 

By following the Alarms Builder procedure, it is expected that the Alarm 
and Events Grouping is similar to the Process Tree organization.

3. To add more groups, right-click on your project (PlantPAx in the example) 
and choose Add Group.

Or, if you like, you can drag-and-drop groups and alarms.

4. Click the Save  icon.
Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016 81



Chapter 4 Configure Alarms
Configure an Alarm and 
Event Banner

This section how to configure the visual and audible components of an
alarm state.

Alarm Banner

Complete the following steps to configure an alarm banner that provides a visual 
representation of the alarm status.

1. In FactoryTalk View Studio, open PlantPAx>Area>PlantPAx_HMI>
Graphics>Displays>(FRAME)P1f Footer.

2. Double-click in the icon bar to access the Alarm and Event Banner 
Properties dialog box.

3. In the Event Subscriptions tab, click Browse (ellipsis …). 
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The Select Scope window appears.

4. Click Process01 and click OK. 

5. Click OK to use the scope defaults on the Alarm and Event Banner 
Properties dialog box. 

If you are using multiple Process areas, such as Process01 and Process02, 
you must create different scope sources.

For example: Area/Alarm:PlantPAx_AE:Process01.

Area/Alarm:PlantPAx_AE:Process02.
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The alarm banner appears in the footer of the Application window. 

Alarm Sounds

Complete the following steps to configure sounds that provide an audible alert 
for an alarm.

1. Repeat step 1 and step 2 on page 82.

2. Click the States tab. 
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3. Check the desired sound actions in the Sound column and click 
Configure Sounds. 

The Alarm Sound Configurator dialog box appears.

4. For each alarm priority, select a sound file from the pull-down list.

5. When you are finished selecting sound files, click OK.

IMPORTANT We recommend that you change the default beep to different sounds 
according to the alarm priority. The default beep is the sound that your 
local computer generates.
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Your configured Alarm Sound Configurator dialog box looks similar to 
the following figure.

If necessary, it is possible to send sound information to the controller to 
create a control for a physical horn that can be configured in the 
Status Tags tab.
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View an Alarm Summary Complete these steps to view alarms in Summary mode.

1. In the FactoryTalk View Studio software tree, open 
PlantPAx>Area>PlantPAx_HMI>Graphics>Displays>P1f Alarm 
Summary. 

2. Double-click in the summary object.

The Alarm and Event Summary Properties dialog box appears.

3. In the Event Subscription tab, click Browse (ellipsis “…”) under the Scope 
text box. 
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The Select Scope dialog box appears.

The Alarm Summary dialog box appears.
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Configure an Alarm Log 
Viewer

You can view and print alarm history databases from the Alarm and Event log. 
Complete these steps.

1. In the FactoryTalk View Studio software tree, open 
PlantPAx>Area>PlantPAx_HMI>Graphics>Displays>P1f Alarm-
History. 

The Alarm and Event Log Viewer Properties dialog box appears.

2. Double-click in the P1f Alarm-History object.

The Alarm and Event Log Viewer Properties dialog box appears.

3. On the Display Filters tab, click Add and type the name of the filter 
(Process01 in the example).

4. Select a group and click Add Where Condition.

The Filter Wizard dialog box appears.

5. Select a 'Where <Group>' from the pull-down list (Contains in the 
example).

6. Click  and select a group name (Process01 in the example). 
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7. On the Application window, click the Program pull-down arrow.

8. Select a program (Process01 in the example) to view the alarm log.

You can also configure global objects to filter and announce alarms by 
alarm group. The objects are in the Rockwell Automation Library of 
Process objects.

9. To filter by alarm group, complete these steps.
a. From the Alarm Objects in the Library global objects folder,

drag-and-drop the Alarm Filter Button onto the Alarm
Summary screen.

b. Right-click the global object and choose Global Object
Parameter Values.
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The Global Object Parameter Values dialog box appears.
c. For the #101 parameter, type a subscription group.
d. For the #102 parameter, type a subscription sub-group.
e. Click OK.

10. To configure a global object to annuciate an alarm on top of a navigation 
button, complete these steps.
a. From the Alarm Objects in the Library global objects folder,

right-click the alarm button.

b. Choose Global Object Parameter Values.
The Global Object Parameter Values dialog box appears.

c. For the #101 parameter, type a subscription group.
d. For the #102 parameter, type a subscription sub-group.
e. Click OK.
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View Alarm System 
Configuration

The System folder includes the L_CPU instruction and the L_ModuleSts 
alarming. Complete these steps to view the alarm system.

1. In the Application tree, open the Area program and choose 
Alarm>PlantPAx_AE,

2. Double-click Alarm and Event Setup. 
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3. Click Diagnostics to view information that has been automatically 
generated by Alarms Builder.

If you are using L_StsModule, the Alarms Builder, by default, creates and 
populates a system alarm summary. 
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Notes:
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Configure Historian

FactoryTalk® Historian software creates historical points (tags) in the system. The 
points provide the foundation to produce analytical data. 

Analytical data includes process variables, trends, and reporting.

Considerations: Consider the following suggestions before starting this chapter:
• Perform any necessary configurations that are contained in the

PlantPAx® Distributed Control System Infrastructure Configuration
User Manual, publication PROCES-UM001.

• The procedures in this chapter use the ‘System Management Tool’
within FactoryTalk Historian software. The tool is available only for 
Historian management computers, such as server, node interface,
and EWS.

• Microsoft Excel software is required to enable the bulk editing capability.
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Figure 7 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 7 - FactoryTalk Historian SE Workflow
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Create Historian Points Complete these steps to create historian points by using the FactoryTalk 
Administration Console.

1. Click Rockwell Automation® software and choose FactoryTalk 
Administration Console.

2. Select the network for the type of FactoryTalk directory.

3. In the Explorer pane, right-click an application (PlantPAx is our example) 
and choose Add Individual Historian Points. 

4. On the Add Historian Points dialog box, click Browse Tags. 

Use an Engineering Workstation 
or a Historian server with these 
procedures.

EWS01 or ASIH01A
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5. In the Tag Browser window, select an object tag (TT01001 in the 
example) in the Folders pane on the left side of the window. 

6. In the pane on the right side of the Tag Browser window, double-click the 
tag to configure as a Historian Point.

Val (Process Variable Value) is the example.

7. Click Add Tags to List and click OK.

The Add Historian Points dialog box reappears with a list of selected tags.
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8. Click OK.

FactoryTalk Historian uses System Management Tools (SMT™) to create 
and maintain historical points. You must have the proper historian 
server connection.

9. Choose Rockwell Software®>FactoryTalk Historian SE>
System Management Tools.

10. In the Servers and Collectives pane, select the Historian server.

11. In the System Management Tools pane, select Point Builder. 

12. Click the Search  button.
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13. In the Tag Search window, type the Tag Mask and click Search.

The tag appears on the Tag Search window.

14. Select the tag and click OK.

The point name and entire path appears on the Point Builder window.

To change the name of the point, continue with the next step; otherwise, 
go to step 17. 

* = Wild Card
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15. Select the tag and click Rename.

16. In the Rename PI Point window, type a new name and click OK. 

17. In the General tab of the Point Builder dialog box, type a tag description 
and engineering units.
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18. Click the Archive tab to configure the range (Zero and Span), typical 
value, and all exception and compression data for the historical point. 

19. Click the Classic tab to view the historical tag path (instrument tag) that 
includes the Data server name.

Our example has the RSLinx® Enterprise name, PlantPAx_DAT. The 
historical point link is broken if any change is made to the RSLinx 
Enterprise application name. 

IMPORTANT Usually, Minimum Range Value = Zero, Span = Maximum Range Value 
minus Minimum Range Value. The Typical Value is between the 
Minimum Range Value and the Maximum Range Value.
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20. To monitor the last historical data, select Current Values and click the 

Search  tool. 
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Create Digital States Historian points can be defined as analog or digital. Digital points can be used to 
enumerate the process states, thus creating a relationship between the value and 
the text state name.

1. Using SMT™ with the proper historian server connection, select Digital 
States and click Add a Digital Data Set.

As an example of how to create your own Digital Data Set, review Table 4.

Add a Digital Data
Set Button

Table 4 - Source Quality Data Examples

Parameter Data Type Description

SrcQ SINT Final PV source and quality.
GOOD 0 = I/O live and confirmed good quality 

1 = I/O live and assumed good quality 
2 = No feedback configured, assumed good quality 

TEST 8 = Device simulated 
9 = Device loopback simulation 
10 = Manually entered value 

UNCERTAIN 16 = Live input, off-specification 
17 = Value substituted at device/bus 
18 = Value substituted by maintenance (Has and not Use) 
19 = Shed, using last good value 
20 = Shed, using replacement value 

BAD 32 = Signal failure (out-of-range, NaN, invalid combination) 
33 = I/O channel fault 
34 = I/O module fault 
35 = Bad I/O configuration (for example, scaling parameters) 
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2. Type a Digital Set name (SrcQ in the example).

3. Type a state name as shown in the Description column of Table 4.

New rows are automatically added as information is entered.

Unused values can be Undefined states. 
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Import Digital Sets and 
States

Instead of manually entering Digital Sets and States, use Process Objects to 
import them.

The Digital Sets and States are available from the Historian folder in the Process 
Library. The Historian information is in a sub-folder (Tools & Utilities) of the 
Files folder in the Process Library download.

Complete these steps.

1. Open the Historian folder.

2. Click Digital States and click the Import button. 
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3. From the Import Digital Set(s) dialog box, click the folder icon.

4. Select a .CSV file from the dialog box.

5. Click Open.

6. Click Create Set(s).
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A minimum number of the recommended Digital Sets is created. This 
procedure does not create the basic Digital Set file for all Process Objects 
digital states.

7. Click Close.
108 Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016



Configure Historian Chapter 5
Define Digital Historical 
Points

The digital set is available only to a digital points type. The FactoryTalk 
Administration Console automatically creates a Float32 (Real) point type for 
each new point. 

This section shows how to change the point type. 

1. To be able to change the digital set, select Digital from the Point 
type pull-down.

IMPORTANT Before continuing with this section, it is necessary to include the Digital 
Historical point such as SrcQ (see step 1 on page 97 through 
step 11 on page 99).
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2. Click the Digital set pull-down menu and select a Digital Set (SrcQ in 
the example). 

3. Click the Save  icon to store the Historian point.
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4. Click Current Values to view the Digital set value corresponding to the 
point value. 
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Excel Add-in Bulk Editing The Microsoft Excel Add-in provides an option for bulk tag editing. 

Complete the following steps. 

1. Open the Microsoft Excel software.

2. Click the Add-ins tab and choose Import Tags from the PI-SMT 
pull-down menu. 

The Import PI Tags dialog box appears.

3. Type a Tag Mask between the asterisks ('TT01001' in the example) and 
click OK. 

IMPORTANT Before starting this section, Microsoft Excel must be configured as an
add-in. See the Excel add-in subsection in Chapter 9 of the PlantPAx 
Distributed Control System Infrastructure Configuration User Manual,
publication PROCES-UM001.
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The Historian points populate the Excel spreadsheet and the PI Tag 
Configurator dialog box appears. 

All necessary fields to edit or to create points are available by using the PI 
tag configurator. This process saves time in comparison to the SMT 
application software. 

4. Click OK.
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5. To export tags, select the point in the Select (x) column and then choose 
Export Tags from the PI-SMT pull-down menu.

The Export PI Tags dialog box appears.

6. From the Mode pull-down menu, select a desired action (Create or Edit in 
the example). 

7. Click OK.

The PI Tag Configurator appears.
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8. Click OK. 

Using the Template Rockwell Automation provides a Historian template inside the Process Library 
that shows suggested points that can be used as digital Historian points. To access 
the Library folder that contains the template, see page 106.

You can select the object points ('x' in the Select(x) column next to the desired 
point) and edit them according to your needs.

The Export Tags functionality is available to create, edit, or delete
Historian points.
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Notes:
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Configure I/O Modules

The PlantPAx® system features flexible, intelligent I/O instrumentation to 
maximize production and reduce downtime. This chapter describes
basic techniques for configuring plantwide communication via I/O modules.

The ControlLogix® system is chassis-based and provides the option to
configure a control system that uses sequential, process, motion, drive control, 
deterministic, and I/O capabilities. Ethernet remote I/O modules transmit end 
device feedback to controllers. The data includes diagnostics, temperature 
measurement, and counter-inputs for process control.

Procedures in this chapter describe how to configure the devices that are shown
in Figure 8. 

Figure 8 - Examples of PlantPAx Distributed I/O Modules
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Figure 9 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 9 - I/O Infrastructure Workflow

Start

Add Remote I/O Chassis

See page 119

Configure Redundant I/O Modules

See page 150

See Chapter 7 Assign I/O and Diagnostics

 Add a Stratix™ Switch Connection

See page 155

Configure I/O Modules

See page 123

Add Diagnostics

See page 158

• Enable Ring Supervisor

• 1756 Analog Input Module
• 1756 Analog Output Module
• 1756 Digital Input Module
• 1756 Digital Output Module
• 1756 Low-speed Counter Module
• Process I/O Linking Devices
• Motor Control Center Components
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Add Remote I/O Chassis This section describes how to add a remote I/O chassis and configure a ring 
supervisor, if applicable. Make sure that the chassis size matches the installed
rack size.

Complete these steps in Logix Designer.

1. In the I/O Configuration tree, right-click the remote I/O network under 
the adapter and choose New Module.

2. In the Catalog tab of the Select Module Type dialog box, select a network 
adapter and click Create.

Use an Engineering Workstation 
with these procedures.

EWS
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3. On the New Module dialog box, type a module name and set an
IP address.

4. Click Change.

5. On the Module Definition dialog box, do the following.

a. See step 6 for the Rack Connection.
b. In the Time Synch Connection pull-down, select Time Synch

and Motion.
c. In the Chassis Size pull-down, select a value for the number of chassis 

slots for the first remote chassis.
d. Click OK.
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6. If you use a rack connection as ‘Rack Optimization’, make sure to configure 
the proper Requested Packet Interval (RPI) under the Connection tab.

If you are not using a rack option, you have to set an RPI for each device.

7. Click Yes to change the module definition, and then OK.

8. To add additional network adapters, repeat step 1 through step 7.

See Configure I/O Modules on page 123 for how to add analog and digital
I/O modules.

Enable Ring Supervisor

If you are using a DLR ring with your application, you must enable the
Supervisor mode. 

Complete these steps.

1. From the Module Properties dialog box of an I/O communication 
module, such as a 1756-EN2TR, click the Network tab.

2. Click the Enable Supervisor Mode box.

IMPORTANT The option ‘Use Unicast Connection over EtherNet/IP’ defaults. For a 
redundant controller, you must disable this option.

IMPORTANT You must be online to perform the following procedure.
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The Module Properties dialog box reappears with additional Supervisor 
Mode actions.

3. Click OK.
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Configure I/O Modules A wide range of I/O modules can be used with smart devices and motors for 
process control in the PlantPAx system. This section describes how to configure 
analog and digital I/O modules.

Procedures in this section use preferred PlantPAx I/O network modules with 
example settings for ControlLogix, HART, Process device, and motor
control modules.

Logix5000™ controllers can be configured with local and remote I/O modules
in multiple networks.

31862-MC

Process Automation System Server (PASS)
Engineering Workstation (EWS) Operator Workstation (OWS)

ControlLogix 
System

Motor Control 
Center

FOUNDATION 
Fieldbus Devices

1715 Redundant I/O Modules

Redundant ControlLogix 
System

Linking 
Device
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1756 Analog Input Module

After you create a Logix Designer application and add a communication module 
to the project (see page 119), complete the following steps to create a module in 
the project.

This procedure shows how to add an 8-channel isolated HART analog input 
model to a 1756 ControlLogix controller.

1. In the Controller Organizer of a Logix Designer application, right-click 
the remote I/O backplane and choose New Module.

The Select Module Type dialog box appears.

2. With the Category tab selected, click the box for each module type (in the 
top left filters box).

ControlLogix analog I/O modules are 
interface modules that convert 
analog signals to digital values for 
inputs. Conversely, the modules 
convert digital values to analog 
signals for outputs. Controllers use 
these signals for control purposes.
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The Analog box is checked in our example so analog modules are our 
selection choices in the middle of the dialog box.

You can also sort by vendor in the top right filter box.

A Logix Designer application also gives you an option to select available 
modules when you are online in the system. The Module Discovery tab 
lists modules that the Logix Designer application automatically detects on 
the backplane.

3. If online, select a module and click Create.

The New Module dialog box appears.

4. On the General tab, do these steps:
a. Type a name for the module.
b. Type a description for the module.
c. Select the slot number for the module.
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5. In the Module Definition box, click Change.

The Module Definition dialog appears.

6. Complete the following actions.

7. Click OK.

A warning message asks you to confirm changes to the module definition.

8. Click Yes.

Parameter Action Values

Connection From the pull-down menu, select 
a connection type.

• Data - has more tabs on the 
Module Properties dialog box than 
Listen-only because of 
configuration settings for alarms, 
calibration.

• Listen-only - has no configuration 
data, does not send output data.

Input Data From the pull-down menu, select 
a data input mode.

• Analog Only
• Analog and HART PV
• Analog and HART by Channel
For details, see the ControlLogix HART 
Analog I/O Modules User Manual, 
publication 1756-UM533.

Configure HART Device Select whether to enable the 
Configure HART Device feature. 
This feature is available only for 
the 1756-IF8IH and 1756-OF8IH 
modules when data format is 
Analog and HART by Channel. If 
you select Yes, a HART Command 
tab is added to the configuration 
dialog, in which you specify 
configuration values to be sent to 
the HART device.

Values that can be added in the HART 
Command tab are PV Damping 
(seconds), PV Units, PV Upper Range, 
PV Lower Range, PV Transfer Function.

Coordinated System Time Not configurable. Timestamped.

Data Format Not configurable. Float.
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9. Click the Connection tab.

10. In the RPI box, type a value to specify a time interval when the data is sent 
to the controller.

11. Leave the default checkbox ‘Use Unicast Connection over EtherNet/IP’ 
and click OK.

Enable HART Channel Data

Complete these steps to configure each channel for HART data.

1. Click the Configuration tab.

2. Check Enable HART for each applicable channel.

We recommend that you Enable HART for any channel that has a 
connected HART device. The information is displayed on the HART 
Device Info tab and accessed by FactoryTalk® AssetCentre software.

IMPORTANT An RPI that is set too fast can affect controller performance. We 
suggest that you specify an RPI that is two times faster than task 
execution or based on inherent properties of the signal being 
measured. For example, a 250 ms task requires a 125 ms time, but 
temperature measurements can be set slower as they are unlikely to 
change that quickly.

IMPORTANT The Unicast checkbox must be disabled (no check mark) for a 
redundant controller.
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You can check Enable HART on channels that have HART field
devices attached.

3. If online, click the HART Command tab to specify HART device 
parameters for each channel. These values are sent to the HART device.

4. Click ‘Enable HART Device PV Range Configuration (Command 35, 
Command 47)’.

5. Set a range for the highest and lowest values for the PV in the specified 
engineering units.

6. Click Apply.

IMPORTANT If you enable the HART device for a PV range, the functionality
provides a continuous update of the variables. The data is exposed
as tags in the I/O module. If you do not want a continuous update of 
the variables, remove the check in the ‘Enable HART Device PV Range
Configuration’ box.
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7. Click the HART Device Info tab.

8. Click Set Device Info.

The Set Device Info button is enabled when the controller is online.

9. Type a tag name, message, and descriptor for the HART device on the 
selected channel and click Set.

This information is sent to and stored in the HART device.

10. Click OK.
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1756 Analog Output Module

This section describes how to enable output parameters for a 1756-OF8IH 
analog module.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 124…127.

The example shows a naming convention for the 1756-OF8IH
analog module.

2. Click the Output State tab.

The dialog box is divided into four sections: 
• Ramp Rate
• Output State in Program Mode
• Output State in Fault Mode
• Communications Failure
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3. With an individual channel button selected, use the information in
Table 5 to configure the parameters.

4. Click OK.

Table 5 -  Output Parameter Configuration

Select Transitions

Ramp in Run Mode (Parameters available in Hard Run mode)

Ramp Rate Check the box and type a value to limit the speed at which an analog 
output signal can change. This option prevents fast transitions in 
output from damaging equipment that the output controls.

Output State in Program Mode (Parameters not available in Hard Run mode)

Hold Last State Click to leave the current output at its last value.

User Defined Value Click and type a specific value to use when the owner controller is 
switched into Program mode. Value range is from
-9,999,999…99,999,999, default is 0.

Ramp to User Defined Value If Hold Last State – This field is disabled.
User Defined Value – Check if you want the output to ramp to the 
user-defined value at the specified ramp rate. 
If unchecked, output signal steps to the User Defined Value 
immediately when you enter Program mode.

Output State in Fault Mode (Parameters not available in Hard Run mode)
Module enters Program mode state if the Connection from Logix is inhibited. If communication subsequently 
fails, all channels of the module remain in Program mode.

Hold Last State Click to leave the output signal at its last value.

User Defined Value Click and type a specific value to use if a fault occurs. Value range is
-9,999,999…99,999,999, default is 0.

Ramp to User Defined Value If Hold Last State – This field is disabled.
If User Defined Value – You can check this option if you want the 
output to ramp to the user-defined value at the specified ramp rate.
If unchecked, the output signal steps to the user-defined value 
immediately when you enter Fault mode.

Communications Failure
If communication fails while in Run mode, the output signal goes to its Fault mode state. If communication 
fails while in Program mode, the output signal behaves as follows.

Leave outputs in Program Mode 
state

Click to leave output signal at the configured Program mode value

Change outputs to Fault Mode state Change output signal at configured Fault mode value if a 
communication fails (connection from controller breaks).
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Enable HART Channel Data

Complete these steps to set up each channel for HART data.

1. Click the Configuration tab.

2. Check Enable HART for each applicable channel.

We recommend that you Enable HART for any channel that has a 
connected HART device. The information is displayed on the HART 
Device Info tab and accessed by FactoryTalk AssetCentre software.

3. Click the HART Device Info tab.

4. Click Set Device Info.

The Set Device Info button is enabled when the controller is online.
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5. Type a tag name, message, and descriptor for the HART device on the 
selected channel and click Set.

This information is sent to and stored in the HART device.

6. Click Set.

1756 Digital Input Module

This section focuses on how to configure individual points of the module for 
On/Off detection and actuation.

Complete these steps.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 124…127.

On the respective Select Module Type dialog box, choose a 1756-IB16D 
diagnostic module or a 1756-IB32/B module.

The diagnostic (‘D’) module has a Comm Format for Full Diagnostics 
Output Data while the output module has only Output Data. The 
graphics are examples only.

ControlLogix Digital I/O modules are 
input/output modules that produce 
information when needed by using 
the produce/consume model.
Digital modules also provide 
additional system functions, such
as system Time Stamp of data and
diagnostic detection.
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2. On the Connection tab, select an RPI and click OK.

3. Click the Configuration tab.

4. Do one of the following in the Enable Change of State columns:
• To enable COS for a point, check the corresponding Off to On or

On to Off box.
• To disable COS for a point, clear the corresponding Off to On or

On to Off box.

5. Click OK.

6. On the right side of the Configuration tab, choose the input filter times 
from the Off–On and On–Off pull-down menus.

These filters improve noise immunity within a signal. A larger filter value 
affects the length of delay times for signals from these modules.

IMPORTANT Skip the next two steps if you are not using the Change of State 
functionality.
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7. Click OK.
For more information, see the ControlLogix Digital I/O Modules User 
Manual, publication 1756-UM058.

1756 Digital Output Module

This section describes how to configure output states if the module goes into 
Program mode or Fault mode.

Complete these steps.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 124…127.

On the respective Select Module Type dialog box, choose a 1756-OB16D 
diagnostic module or a 1756-OB32 module.

The diagnostic (‘D’) module has a Comm Format for Full Diagnostics 
Output Data while the output module has only Output Data. The 
graphics are examples only.
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2. After you define the RPI and click OK, click the Configuration tab.

3. From the Program Mode pull-down menu, choose the module output state 
during Program mode:
• On
• Off
• Hold (Retain current output state)

4. From the Fault Mode pull-down menu, choose the module output state 
during Fault mode:
• On
• Off
• Hold (Retain current output state)

5. Click OK.

For more information, see the ControlLogix Digital I/O Modules User 
Manual, publication 1756-UM058.
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1756 Low-speed Counter Module

This section describes Configuration tabs so the counters can count pulses from 
devices such as proximity switches and photoelectric sensors. The counts are 
presented as an accumulated count or frequency.

Complete these steps.

1. To name the module, select the chassis slot, and define the RPI,
repeat step 1 through step 11 on pages 124…127.

On the respective Select Module Type dialog box, choose a 
1756-LSC8XIB8I module.

2. After you define the RPI and click OK, click the Input Configuration tab.

This tab lets you associate hardware inputs of the module to the counters.

3. Select a counter to tie the counter control function to a standard
hardware input. 

The state of the external input device controls the designated counter

4. Check Invert to change the input count direction, if applicable.

5. Use the pull-down menus to choose the desired input filter times.

6. Click OK.

The low-speed counter module is 
used in Process applications to save 
controller bandwidth. The module 
can be used as a pulse totalizer
for flowmeters or a speed sensor
in conveyors. 
Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016 137



Chapter 6 Configure I/O Modules
7. Click the Counter Configuration tab.

8. Click a counter to configure frequency per pulses.

9. Click OK.

For more information, see the ControlLogix Low-speed Counter Module 
User Manual, publication 1756-UM536.
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Process I/O Linking Devices

This section shows how to configure Fieldbus Foundation and PROFIBUS PA 
linking devices to communicate field device information via CIP networks to a 
Logix controller.

Complete these steps.

1. Right-click the network of the remote I/O, and choose New Module.

2. On the respective Select Module Type dialog box, choose a 
1788-EN2FFR (fieldbus) or 1788-EN2PAR (PROFIBUS) module.

3. Name the device and type an IP address.

4. Click OK.

5. On the Connection tab, set the RPI value and click OK.

For more RPI information, see the Important on page 127.

6. In the Controller Organizer, double-click the linking device.

The Module Properties dialog box appears.

These modules are referred to as linking 
devices because they provide a gateway 
between Ethernet and ControlNet 
networks to FOUNDATION Fieldbus and 
PROFIBUS PA networks.
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7. Click the Configuration tab.

Once the linking device is connected to the controller, you can see the 
linking device in the Configuration tab.
• Master green in the configuration tree = linking device is online
• Master gray in the configuration tree = linking device is offline

For more information, see the following documents:
• EtherNet/IP and ControlNet to FOUNDATION Fieldbus Linking 

Devices User Manual, publication 1788-UM057
• EtherNet/IP and ControlNet to PROFIBUS PA Linking Devices User 

Manual, publication 1788-UM058

Live List
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Motor Control Center Components

This section describes how to configure MCC components, including 
PowerFlex® drive, SMC™, and overload relay examples.

PowerFlex 755 Example

Complete these steps.

1. In the I/O Configuration tree, right-click the remote I/O network and 
choose New Module.

2. From the Select Module Type dialog box, select a PowerFlex 755 module 
and click Create.

IMPORTANT This section shows how to configure the PowerFlex 755 drive. You can use 
basically the same procedures for configuring other PowerFlex drives.
The Datalinks must be configured before using the respective PowerFlex 
procedures. For Datalink information, see the following Rockwell Automation® 
Library of Process Objects Add-On Instructions:
• PowerFlex 755 (P_PF755), publication SYSLIB-RM040
• PowerFlex 753 (P_PF753), publication SYSLIB-RM044

Low-voltage motor control centers (MCC) 
house starters, soft-starters, and drives as an 
alternative to wiring each device individually. 
Simplified programming creates a single 
network for complete machine control.
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3. Type a name and IP address for the drive.

4. In the Module Definition section, click Change.

The Module Definition dialog box appears.

5. Click Match Drive.
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6. Click Full on the message window.

7. Select the drive and click OK.

8. Click OK to the message that the online action is successful.

The Module Definition dialog box reappears with the input datalinks for 
the matching drive.

9. Click OK.

10. Click Yes to accept the module changes.

11. Click the Connection tab and set an RPI value.

12. Click OK.

For more information, see the PowerFlex 750-Series AC Drives 
Programming Manual, publication 750-PM001.
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PowerFlex 525 Example

Complete these steps.

1. In the I/O Configuration tree, right-click the remote I/O network and 
choose New Module.

2. From the Select Module Type dialog box, select a PowerFlex 525 module 
and click Create.

3. Type a name and IP address for the drive.

4. In the Module Definition section, click Change.

The Module Definition dialog box appears.

IMPORTANT This section shows how to configure the PowerFlex 525 drive. You can use 
basically the same procedures for configuring other PowerFlex drives.
The Datalinks must be configured before using the respective PowerFlex 
procedures. For Datalink information, see the following Rockwell Automation 
Library of Process Objects Add-On Instruction:
• PowerFlex 523/525 (P_PF52x), publication SYSLIB-RM048
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5. Click Match Drive.

6. Click Upload Entire Device.

7. Click OK after a review of possible changes to the module definition on a
pop-up window.

8. Click OK on the Module Definition dialog box.

9. Click Yes to accept the module changes.

10. Click the Connection tab and set an RPI value.

11. Click OK.

For more information, see the PowerFlex 520-Series Adjustable Frequency 
AC Drive Programming Manual, publication 520-UM001.
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Smart Motor Controller (SMC™-50) Example

Complete these steps to use a module that is designed to maximize the efficiency 
of motor starts and stops.

1. In the I/O Configuration tree, right-click the remote I/O network and 
choose New Module.

2. From the Select Module Type dialog box, select an SMC-50 module and 
click Create.

3. Type a name and IP address for the drive.

4. In the Module Definition section, click Change.

The Module Definition dialog box appears.

5. Click Match Drive.

The Module Definition dialog box reappears with the input datalinks for 
the matching drive.

6. Click OK.

7. Click Yes to accept the module changes.

IMPORTANT This section shows how to configure the SMC-50 smart starter. You can use 
basically the same procedures for configuring other motor starters.
The Datalinks must be configured before using the respective SMC procedures. 
For Datalink information, see the following Rockwell Automation Library of 
Process Objects Add-On Instructions:
• SMC-50 (P_SMC50), publication SYSLIB-RM052
• SMC Flex (P_SMCFlex), publication SYSLIB-RM053
146 Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016

http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/syslib-rm052_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/syslib-rm053_-en-p.pdf


Configure I/O Modules Chapter 6
8. Click the Connection tab and set an RPI value.

9. Click OK.

For more information, see the SMC-50 Solid-State Smart Motor 
Controller User Manual, publication 150-UM011.

E300™ Electronic Overload Relay Example

Complete these steps to add an overload relay that features a modular design and 
diagnostic information for motor control applications.

1. In the I/O Configuration tree, right-click the remote I/O network and 
choose New Module.

2. From the Select Module Type dialog box, select an E300 relay module and 
click Create.

IMPORTANT This section shows how to configure the E300 overload relay. You can use 
basically the same procedures for configuring other protection relays.
The Datalinks must be configured before using the respective SMC procedures. 
For Datalink information, see the following Rockwell Automation Library of 
Process Objects Add-On Instructions:
• E300 (P_E300Ovld), publication SYSLIB-RM051
• E1 Plus (P_E1PlusE), publication SYSLIB-RM049
• E3/E3 Plus (P_E3Ovld), publication SYSLIB-RM050
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3. Type a name and IP address for the drive.

4. In the Module Definition section, click Change.

The Module Definition dialog box appears.

5. Click Upload
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6. Click OK on the pop-up window when the Upload completes.

7. Click OK again on the Module Definition dialog box.

8. Click OK on the New Module dialog box.

For more information, see the Bulletin 193/592 E300 Overload Relay 
User Manual, publication 193-UM015.
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Configure Redundant I/O 
Modules

This section shows how to configure a 1715 redundant I/O system with a remote 
I/O chassis on an EtherNet/IP network. Using a ControlLogix controller, this 
redundant system provides fault tolerance with a redundant adapter pair and 
multiple I/O modules for enhanced diagnostics.

1. To set up a network adapter, right-click an Ethernet bridge in the I/O 
Configuration tree and choose New Module.

2. On the Catalog tab, use the filter to select a 1715 Ethernet adapter and 
click Create.

The 1715 redundant I/O platform offers 
flexibility, with no special wiring, and no user 
programming code or Add-On Instructions. 
The redundant I/O system requires less 
engineering because no additional hardware
is required.
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3. On the New Module dialog box, type a name for the adapter and set an
IP address.

4. Click the Connection tab and select an RPI value.

5. Click OK.
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6. Right-click the 1715 network adapter and choose New Module.

7. Select a 1715-IF16 analog input module, name it, and pick a slot number.

8. Click the Configuration tab to check the channel signals, and click OK.
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9. Repeat step 6 through step 8 to create a 1715-OF8I analog output module.

10. Click OK.

11. Repeat step 6 through step 8 to create a digital diagnostic
input (1715-IB16D) module.
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12. Click OK.

13. Repeat step 6 through step 8 to create a digital diagnostic
output (1715-OB16DE) module.

14. Click OK.

All 1715 I/O modules are added to the remote I/O chassis.

For more information, see the Redundant I/O System User Manual, 
publication 1715-UM001.
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Add a Stratix Switch (CIP) 
Connection

Complete these steps to configure a managed switch to leverage ports for sending 
messages only to the device that needs or requests the communication.

1. Right-click on an Ethernet adapter and choose New Module.

The Select Module Type dialog box appears.

2. Select a Stratix managed port adapter and click Create.

IMPORTANT A CIP VLAN must be enabled for the switch to perform the following steps. To 
enable CIP, see Chapter 1 in the PlantPAx Distributed Control System 
Infrastructure Configuration User Manual, publication PROCES-UM001.

IMPORTANT The Stratix 5410 is accessed via the Managed Ethernet Switch category 
filter. Other switches are accessed by using the Communication 
category type.
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3. On the New Module dialog box, type a module name and assign an
IP address.

4. Click Change, and then type a password and click OK on the Module 
Definition dialog box.

5. Confirm the password and click OK.

The New Module dialog box reappears.
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6. To enable a redundant power supply, if applicable, click ‘Enable
Dual Power Supply Alarm’ on the switch configuration for the
module properties.

Repeat step 1 through step 6 to configure all of your system switches.

A list of switches appears in the Controller Organizer.

For more information, see the Stratix Managed Switches User Manual, 
publication 1783-UM007.
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Add Diagnostics This section describes how to add diagnostics to an I/O module. Complete
these steps.

1. In the Controller Organizer, open the Controller Status folder.

2. Right-click Diagnostics and choose Add>New Routine.

The New Routine dialog box appears.

3. Type a routine name and click OK.

IMPORTANT Controller Status is among nine predefined periodic tasks in the controller 
template. A diagnostics folder is within the Controller Status periodic task.

TIP For a remote rack, include one routine per rack. Each rung is to contain 
one Module_Sts.
For an MCC, include one routine for each MCC device.
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4. In the Diagnostics folder, double-click the LCPU routine to access a 
ladder project.

5. Click a rung and type JSR, and then select the subroutine to access a jump 
to a subroutine box.

6. Click the routine name box inside the JSR command, and type the routine 
name that you created.

7. Double-click the routine that you created to access a ladder rung.

8. Right-click the rung and choose Import Rungs.

9. Browse to the Process Strategies folder and select the Module Status 
process strategy.
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10. Click Open.

11. On the Import Configuration dialog box, click the Find/Replace button 
to replace the default module tag with your device.

12. Click Replace All.

13. Repeat step 11 and step 12 to replace ‘TagDescript’ with your own 
description (EtherNetIP 02 is the example).

14. Click OK.
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15. Repeat step 7 through step 14 for all modules in the I/O configuration.

16. Save your work.
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Notes:
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Chapter 7

Assign I/O and Diagnostics

After you have defined your I/O modules and built the process strategies, you 
must connect the I/O definition to a physical device. This chapter describes how 
to assign the I/O tags.

When we assign I/O, we are creating a relationship between process strategies 
and the device. The I/O module is connected to the tags of the process strategy. 

This chapter illustrates the following three program examples:
• An analog input channel with diagnostics
• An MCC device that uses a COP instruction to transfer raw data
• Analog input tags assigned to connectors within a PID loop

Typically, you can use the basic analog input procedures in the first example to 
assign I/O tags to devices. The other two examples have additional requirements, 
such as the creation of programs and routines for drives because of differing
data types.
Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016 163



Chapter 7 Assign I/O and Diagnostics
Figure 10 contains the topics that are described in this chapter. Click or see the 
page number for quick access to a section.

Figure 10 - Assign I/O Workflow

Start

Connect Analog Input Channel with Diagnostics

See page 165

Connect an MCC Device

See page 170

Connect a PID Loop

See page 179

See Chapter 8 Configure Asset Management Tools

• Create Routines
• Assign Diagnostics
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Connect Analog Input 
Channel with Diagnostics

This section shows how to connect I/O to the analog input channel process 
strategy (PS_AIn_Chan). Complete these steps.

1. In a Logix Designer application, open an existing program.

2. Double-click Parameters and Local Tags under the Area01>Logic and 
Tags folders.  

3. Right-click a column header and select Toggle Column>Connections. 

IMPORTANT The first time that you perform this procedure, the Connections column 
is not visible. Complete step 3 to show the Connections column.
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The process strategy tags that appear in the Edit Tags tab show 
connections. 

See Build Process Strategies on page 26.

4. In the Connections column, click the pull-down to display a list of 
I/O tags for the Inp_Raw Process Strategy.

IMPORTANT The tag names can be broken down into the remote module, slot 
number, and I/O module. 

The first letter in the I/O Module Data represents the type of I/O the 
tag is:
• I = Input
• O = Output
• C = Configuration

Remote I/O Adapter

Slot Number
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5. Click a data tag (LGXC01EN02R01:1:l.Ch0.Data) in the example) to 
place the tag in the Connections text box.

Local Process Strategy Tags
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6. To place the tag in the Connections text box, click an I/O tag. 

7. Repeat step 4 through step 6 to assign a Fault tag to the 
Inp_Raw_ChanFault Process Strategy.

8. For the Module input fault (Inp_Raw_ModFault) Process Strategy, select 
Diagnostics from the Show parameters from other program pull-down. 
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9. Click the Connections pull-down and double-click an I/O diagnostics tag.

See Chapter 9 for creating I/O diagnostic codes.

10. To view the connections, open the routine. 
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Connect an MCC Device Drives typically have different data types. You can create a program with specified 
input and output routines to send raw data to a compatible data type. 

Complete the following steps.

1. In a Logix Designer application, open an existing program.

2. In the Controller Organizer, right-click a task and choose 
Add>New Program. 

The New Program dialog box appears.

3. Type a program input name.

Our example (EtherNetIP_Inputs_D) has an _D because we created our 
program from the Task_D_500ms folder. When you create programs from 
different tasks add an _x, with ‘x’ denoting the letter of the selected Task 
folder. For example, EtherNetIP_Inputs_C.

4. Click OK.
170 Rockwell Automation Publication PROCES-UM003A-EN-P - March 2016



Assign I/O and Diagnostics Chapter 7
5. Repeat step 2 on page 170 through step 4 on page 170 and type a program 
output name.

6. To organize programs within a task, right-click the Task in the Controller 
Organizer and choose Properties.

The Task Properties dialog box appears.

7. Click the Program/Phase Schedule tab.

8. Click a program that you want to move and click the Up or Down arrows 
to move the program. Position the programs in the following execution 
order (top to bottom): Input Process Strategies Output

9. Click OK.
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10. Click the Logical Organizer tab and drag-and-drop the Inputs and 
Outputs programs into the System folder. 

11. Save your work.
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Create Routines

Complete the steps to create routines for the programs.

1. On the Logical Organizer, right-click a Program and choose 
Add>New Routine.

The New Routine dialog box appears.

2. Type ‘MainJSR’ for a jump to subroutine, make sure that the assignment is 
'Main', and click OK.

3. Repeat step 1 and step 2 for an EtherNetIP Inputs routine name.

We suggest that you create one network name for a routine. This routine 
can contain all network adapters owned by this communication adapter.

4. Repeat step 1 and step 2 for an EtherNetIP Outputs routine name.
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5. In the Logical Organizer, double-click MainJSR.

6. Double-click a rung, type JSR, and press Enter.

An instruction that is named 'JSR' is shown in the rung.

7. In the instruction, select the Routine Name that you created in step 2 
(MainJSR in the example) from the pull-down list.

8. Repeat step 6 and step 7 for EtherNetIP_Outputs.

9. Under EtherNetIP_Inputs, open the LGXC01EN02 routine, type COP, 
and press Enter.

A Copy instruction transfers raw data only and ignores data types. The 
instruction lets you use a compatible data type to connect the tags.

10. In the instruction, click the Source pull-down arrow to select a drive input 
from the list.
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11. In the instruction, click the Destination pull-down arrow and select a 
destination data type. 

For MCC components, select the drive input that is created when 
importing process strategies for drives.

The destination data type appears in the COP instruction.

12. In the instruction, type a Length of '1'. 
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13. Repeat step 9 through step 11 to tie the EtherNetIP_Outputs tag to 
the I/O.

14. If online, click the Finalize All Edits in Program  icon.

The Finalize all edits in program window appears.

15. Click OK to finalize edits in all programs.

16. Save the program.

17. To add more drives, repeat step 1 through step 16.

IMPORTANT Observe that the Source and Destination are opposite for the COP 
output instruction.

IMPORTANT You must finalize EtherNetIP_Inputs, EtherNetIP_Outputs, and 
Process Strategies.
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Assign Diagnostics

Complete these steps to connect the process strategy tags to the I/O Module
(PowerFlex® 755 in our example).

1. In the Logical Organizer, open a program from the Process01 folder and 
double-click Parameters and Local Tags.

The Edit Tags tab opens with the program tags.
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2. To view the connections, click one of the tags in the Logical Organizer. 
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Connect a PID Loop Complete the following steps to assign I/O to a PID loop.

1. In the Logical Organizer, open the Process folder and double-click 
Area01>Logic and Tags>Parameters and Local Tags.

2. Assign the I/O and the diagnostics by using the program connections. 

3. Click a data tag to place the tag in the connections text box.

4. Save your work.
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Notes:
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Chapter 8

Configure Asset Management Tools

This chapter describes how to use application tools available with the 
FactoryTalk® AssetCentre software.

For example, a Device Type Manager (DTM) contains Field Device Tool (FDT) 
compliant interfaces to enable configuration and communication between 
devices and the system. The interface helps create device parameters for 
diagnostics, maintenance, and calibration purposes.

Disaster recovery is another benefit of AssetCentre software. Back up master files 
of controller applications help to safeguard against a loss of data.

An Audit Log monitors FactoryTalk-related software products and logs user 
interactions. For details, see Chapter 10 in the PlantPAx® System Infrastructure 
Configuration User Manual, publication PROCES-UM001.

Considerations Consider the following suggestions before starting this chapter:
• We strongly recommend additional licensing for disaster recovery that 

automatically backs up supported devices.
• If your are using HART, Fieldbus Foundation, and/or PROFIBUS PA 

process devices, we recommend the DTM procedures that start on 
page 183. DTMs contain device-specific data to enhance configuration 
and communication with the system.

• Instrument calibration is an option with AssetCentre software.
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Figure 11 shows the topics that are described in this chapter. Click or see the page 
number for quick access to a section.

Figure 11 - AppServ-Asset Workflow 

Start

Use a DTM for Device Configuration

See page 183

Configure Disaster Recovery

See page 198

See Chapter 9 System Diagnostics

• Design for the Device

• Configure a Logon
• Add an Asset
• Create a Working Folder
• Create a Backup Schedule
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Use a DTM to configure
a Process Device

This section describes basic Device Type Manager (DTM) configuration. Use the 
DTM with FactoryTalk® AssetCentre to connect Process Devices. You can 
perform this process in the AppServ-Asset server, but typically the EWS is used to 
store software.

Complete these steps.

1. Click the Programs  symbol and choose Rockwell 
Software®>FactoryTalk AssetCentre Client>AssetCentre Client.

The AssetCentre Client window appears. 

2. Choose Tools>DTM Catalog.

The DTM Catalog window appears. 

IMPORTANT For procedures on how to configure the AppServ-Asset server, see
the PlantPAx Distributed Control System Infrastructure Configuration User 
Manual, publication PROCES-UM001.

Use an Engineering Workstation 
(preferred) or AppServ-Asset 
server with these procedures.

EWS01 or ASAM01
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3. Click Scan Now to update the catalog.

4. Click Close when the scan is complete.

5. In the AssetCentre, click the Tasks tab and choose DTM Networks.

IMPORTANT Every newly installed DTM requires a scan.
If you do not have a new DTM installed, skip this step.
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The DTM Networks window appears.

6. Right-click Host PC>Add DTM.

The Add DTM window appears. 

The same procedure must be performed on PROFIBUS PA and Fieldbus 
Foundation modules. 

IMPORTANT The HART module must be configured in the I/O configuration tree.
For details to enable HART channel data, see Chapter 6.
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7. Select DTM 'RSLinx® 1756 Backplane (ControlLogix®)' and click OK
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8. In the DTM Networks window, right-click '(RSLinx 1756 Backplane)' 
and choose Configuration.

9. Select the path to the backplane.
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The Select 1756-Backplane dialog box opens.

10. Select 'backplane, 1756-A7/C' and click OK.

11. In the DTM Networks window, click Next. 
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12. In the DTM Networks window, right-click '(RSLinx 1756 Backplane)' 
and choose Add DTM. 

The Add DTM window appears. 
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13. Select DTM '1756-IF8IH/A' and click OK.

14. Select the module slot number and click OK. 
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15. In the DTM Networks window, right-click ' - (RSLinx 1756 
Backplane)'>1756Bus> - (1756 IF8H/A1)' and choose Online.\

16. Click Scan Network.

The Select Communications Channel window appears. 

17. Select the channels to perform the Scan Network on and click OK.
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Design for the Device

Any items found (Temperature Transmitter TT01001 in the example) are listed 
in the Items Found area of the Scan Results window. 

1. Click OK.

2. In the DTM Networks window, click Close.
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3. In the FactoryTalk AssetCentre window, select Design mode. 

4. Drag-and-drop the Instrument asset into the AssetCentre tree. 
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5. Click DTM Addressing Info and then click Browse (ellipsis, …) to open 
the Select a DTM device from the DTM network window. 

6. Select a Process Device (TT01001 in the example) and click OK.
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7. Type the device name or tag and click OK.

8. Select DTM View, click the device (TT01001 in the example), and
click Online. 

IMPORTANT The Upload, Download, and Diagnostics functionality is also available.
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9. Click Open to configure the device.

The Online configuration tab opens.
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10. Make any configuration changes you like.

When you are finished with changes, you can exit the FactoryTalk 
AssetCentre window. You also can return to the Home tab to make
more changes.
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Configure Disaster Recovery Disaster Recovery software creates back-up files. This procedure schedules a 
comparison between master files, and processor program and data files. 

Configure a Logon

Complete these steps to configure the user name and password to enable the 
Agent service.

1. Click the Programs  symbol and choose Rockwell 
Software>FactoryTalk AssetCentre Agent>Agent service logon config 
tool. 

The Agent Services Logon Configuration dialog box appears. 

2. Type a user name (AssetCentre_DR in the example), password, and 
click OK.

After creating the logon, you must confirm that you need to restart 
the Agent Service. 

IMPORTANT This logon cannot be used until the service is restarted.
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3. Click Yes.

4. Perform step 1 and step 2 to reopen the Agent Service Logon 
Configuration dialog box. 

5. In the next dialog box that appears, confirm that the information is correct 
and click Close.

The Agent Service Logon Configuration dialog box closes. 

Add an Asset

To add a Logix5000™ controller as a new asset, complete the following steps:

1. In the FactoryTalk AssetCentre, click Design.

2. Drag-and-drop the Logix5000™ Controller into AssetCentre.
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The Add a Logix5000 Controller to AssetCentre dialog box appears. 

3. Choose Configuration Data and use Browse (Ellipsis, …) to find and 
click Add.

An .ACD file appears in the right side of the window. 

4. Select the .ACD file and click OK.
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5. In the Add a Logix5000 Controller to AssetCentre dialog box, choose 
Addressing Info.

6. Click Browse (ellipsis ‘…’).

The Selecting Device For Asset Type window appears.

7. Select the path to the controller and click Select.
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8. In the Add a Logix5000 Controller to AssetCentre dialog box, type the 
controller name (PAC01 in the example) and click OK. 

Create a Working Folder

Complete these steps to set the workbook (working folder) in any level
of structure.

1. In the FactoryTalk AssetCentre window, select Archive.
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2. In the Archive tab, click Set for the Working folder. 

The Set Working Folders dialog box appears.

3. If the System working folder is incorrect, click Browse (ellipsis ‘…’).

4. In the Browse For Folder dialog box, navigate to the desired folder, select 
it, and click OK.

5. In the Set Working Folders dialog box, click OK.
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6. In the FactoryTalk AssetCentre software, make sure the Check In, Check 
Out, and Revision Control procedures are available in the system.
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Create a Backup Schedule

Complete these steps to configure a backup schedule.

1. In the FactoryTalk AssetCentre Client, click the controller.

2. Select Schedules.

The Schedules tab appears. 

3. In the Schedules tab, Click New.

The 'New Schedule Wizard - Step 1 of 3' dialog box appears. 

4. Make sure that the Operation is correct.
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5. Type the name for the schedule and click Next.

The 'New Schedule Wizard - Step 2 of 3' dialog box appears. 

6. From the pull-down menu, select the Start Time.

7. Set the Timing Properties.
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8. Set the Maximum Runtime. 

9. Click Next.

The 'New Schedule Wizard - Step 3 of 3' dialog box appears. 

10. Select the Email notification option and click Finished.

IMPORTANT A maximum runtime of 0.0 means that there is no maximum limit.
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11. In the FactoryTalk AssetCentre - Schedules tab, click Run Now to test the 
functionality of the new schedule outside of the scheduling period.

The backup of the controller runs. After a few minutes, the backup 
is complete. 
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Add Basic System Diagnostics

This chapter describes how to add controller and PASS server diagnostics to your 
system health screen that is provided in the HMI template. HMI templates are 
provided with the Rockwell Automation Library of Process Objects. As you 
develop your project, you can add additional diagnostics for your system. 

We recommend that you familiarize yourself with the HMI template. See 
Chapter 3 for examples and descriptions of the template.

Figure 12 shows diagnostic displays that are explained in this chapter.

Figure 12 - HMI Server Status Example
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Figure 13 shows the topics that are described in this chapter. Click or see the page 
number for quick access to a section.

Figure 13 - Basic Diagnostic Workflow 

Start

Configure Controller Diagnostics

See page 211

Add Controller Diagnostics to an HMI Project

See page 212

Configure PASS Server Status

See page 216

Additional Resources

See page 221

End
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Configure Controller 
Diagnostics

The Logix Controller CPU Utilization (L_CPU) Add-On Instruction faceplate 
monitors a Logix controller and provides controller information on the system 
status page of the HMI template. This status information includes controller 
CPU utilization, communication usage, memory usage, task scan times, and 
controller loading.

1. In the Studio 5000 Architect™ application, expand a controller project and 
open diagnostics under Controller Status.

2. Right-click LCPU and choose Open Routine.

The Logix Designer application opens with the LCPU routine.

3. In the MOV instruction, type the controller slot number into the Source 
text box.

4. Save your project.

Use an Engineering Workstation 
with all procedures.

EWS
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Add Controller Diagnostics to 
an HMI Project

Follow these steps to add controller diagnostics to your HMI project.

1. From the Architect application, right-click an application and choose 
Open in Designer.

2. From your FactoryTalk® View project, expand your HMI application and 
displays.

3. Right-click a system diagnostic display (for example, P1f System) from the 
template and choose Open.

See page 58 for descriptions of the components in an HMI project.

4. From the Global Objects folder, right-click (RA-BAS) Logix Graphics 
Library and choose Open.
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5. Right-click the controller graphic in the L_CPU box and choose Copy.

6. On the P1f System display, right-click anywhere in the window and
choose Paste.
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7. Right-click the L_CPU graphics on the P1 System display and choose 
Global Object Parameter Values.

8. Type the controller shortcut string in #101.

9. Select the shortcut in #102, and click OK.

10. Save the display.

11. Open the HMI template that you created in Chapter 3.

TIP To open the L_CPU faceplate, you must open the Display folder under 
the FactoryTalk View SE folder.
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12. On the HMI display, click the System Status icon.

On the HMI template, the controller graphic has some animation that 
shows the position of the key switch and controller status indicators.

13. Click the controller to access the controller status faceplate.

Tabs on the faceplate also provide information on the CPU usage and the 
status of controller memory and connections. 

For complete details, see the PlantPAx® Library of Logix Diagnostic 
Objects, publication PROCES-RM003.

System Status

Home Tab

Communication Tab

CPU Usage Tab

Connections Tab

Maintenance Tab

Controller Memory Tab
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Configure PASS Server Status In this section, we describe how to add diagnostics for your PASS servers. These 
diagnostics provide information on the software components that run on the 
PASS, including an HMI server, data server, and an alarm and event server.

1. Open Knowledgebase Answer ID 44624 at http://
rockwellautomation.custhelp.com and download the
zip attachment.

2. Right-click the .zip file and choose Extract All.

3. Open the View 5.0 CPR9 folder.

4. Right-click the file and choose Open.

5. Right-click server status-state cpr9 v505 and choose Extract All.

The example shows the unzipped files.

6. In the FactoryTalk View HMI application, right-click Displays and choose 
Add Component Into Application.
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7. Open the server status-state cpr9 V505.gfx file from the files that were 
unzipped in step 5.

8. Right-click the imported display and choose VBA Code.

9. Find the text circled in the example and type the name of your HMI server 
and data server.

10. Save the changes to the VBA code and close the server status display.

11. Open a system display.

For example, P1x.
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12. From the Objects menu, choose Push Button>Button.

13. Click the display and drag the mouse to draw a button.

14. From the Action tab, click Browse (ellipse ‘…’) next to Release action.
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15. From the All Commands and Macros list, select Display and click Next.

16. From the File pull-down menu, choose the server status display.

17. Click Finish.
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18. On the Button Properties dialog box, click the Up Appearance tab.

19. In the Caption text box, type Server Status.

20. Click OK.

21. Save the changes to the P1 System display.

22. Run the client file and access the System Status page.

23. Click Server Status.

The Server Status display appears.
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The example shows a networked station application with the FactoryTalk 
server, HMI server, and data server on one workstation. None of the 
servers is redundant in this application example.

Add These Additional 
Resources

The following resources are available to assist with developing your application.

TIP We recommend that diagnostic alarms for network adapters and I/O 
modules be added to the Alarm server. The alarms are displayed on the 
alarm banner and are included in the alarm log and history.

Topic Description Where To Find Information

DLR diagnostics The Device Level Ring (DLR) faceplate shows network 
status and where a break is in the EtherNet/IP network.

The DLR diagnostics faceplate application can be 
downloaded from the Rockwell Automation® Sample Code 
website at http://samplecode.rockwellautomation.com 

L_ChangeDet, L_Redun, L_TaskMon library objects The PlantPAx Library of Logix Diagnostic Objects monitor 
Logix controllers on the network, checking for changes 
that impact operation for primary and secondary
controller status.

PlantPAx Library of Logix Diagnostic Objects,
publication PROCES-RM003
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Notes:
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		D10		Combination: 4 color cover, with 2 color body		Cover 160gsm with           Body 80gsm		90# index, 20# bond

				Gray shading indicates Obsolete Print Catagories

		Just In Time (JIT) or Off Set (OS)?

		Use these guidelines to determine if your publication should be JIT (just in time/print on demand) or if it would be more economical to print OS (offset/on a press). OS print jobs require an RFQ (Request For Quote) in US. If your job fits into the “Either” category, an RFQ is recommended, but not required. In the US, RA Strategic Sourcing will discourage or reject RFQs for jobs that fall within the JIT category. Guidelines differ for black & white and color printing, so be sure to check the correct tables.

		Black & White Printing

		Color Printing

		Color Printing





Print Spec Sheet

		JIT Printing Specifications				RA-QR005J-EN-P  -  6/14/2013

		Printing Specification		YOUR DATA HERE		Instructions																																				NO

		(required) Publication Number:		PROCES-UM003A-EN-P		Sample: 2030-SP001B-EN-P																														11” x 17”				LOOSE -Loose Leaf		YES		Pre-sale / Marketing				TOP

		Use Legacy Number:				YES or NO																														8.5” x 11”				PERFECT - Perfect Bound				A1				LEFT

		Legacy Number if applicable:				Sample Legacy Number: 0160-5.33																														8.375” x 10.875				SADDLE - Saddle Stitch				A2				RIGHT				CORNER

		Publication Title:		PlantPAx Distributed Control System Application Configuration User Manual		Sample: ElectroGuard Selling Brief
80 character limit - must match DocMan Title																														8.25” x 11” (RA product profile std)				PLASTCOIL - Plastic Coil (Coil Bound)				A4				BOTTOM				SIDE

		Used in Manufacturing:				YES or NO - If Yes, must have Part No. listed below																														8.25” x 10.875”				STAPLED1 -1 position				A3

		Part Number:				If SAP Part Number, be sure to enter PN- before the number																														7.385” x 9” (RSI Std)				STAPLED1B - bottom 1 position				A5

		(required) Category		D6		Select Print Category A,B,C or D from category list, on "Introduction_Category Types" tab																														6” x 4”				STAPLED2 - 2 positions				A6

		Paper Stock Color:				White is assumed.  For color options contact your vendor																														5.5” x 8.5” (half-size)				THERMAL - Thermal bound (Tape bound)				A7

		Ink Color:				One color assumes BLACK / 4 color assume CMYK / Indicate PMS number here																														4.75” x 7.75”				THERMALO - Thermal Bound (Tape bound - offline)				A8

		(required) Page Count of
Publication:		228		Total page count including cover. Enter PAGE count, not SHEET count																														4.75” x 7” (slightly smaller half-size)								A9

		(required) Finished Trim Size Width:		8.5” x 11”		This is sheet size, before folding																														4.25" x 5.50"								Post Sale / Technical Communication

		Fold:				Review key below. Leave blank if folded for saddle stitching																														4” x 6”								B1

		Finished Fold Size:				This is size after folding is completed																														3” x 5”								B2

		Binding/Stitching:		PERFECT - Perfect Bound		Review key below																														9” x 12” (Folder)								B3						None

		Stitching Location:		SIDE		Blank, Corner or Side																														A4 (8 ¼” x 11 ¾”) (210 x 297 mm)								B4						Half or V or Single Fold

		Drill Hole (Yes/No):		YES		All drilled publications use the 5-hole standard, 5/16 inch-size hole and a minimum of ¼ inch from the inner page border.																														A5 (5.83” x 8.26”) (148 x 210 mm)								B5						C or Tri-Fold

		Number of Tabs Needed:				5 tab in stock at RR Donnelley																														36” x 24” Poster								Catalogs						DbleParll

		Number of Pages per Pad:				Average sheets of paper. 25, 50 75,100 Max																														24” x 36” Poster								C1						Sample

		Glue Location on Pad:				Glue location on pads																														18” x 24” Poster								C2						Short (must specify dimensions between folds in Comments)

		(required) Business Group:		Marketing Commercial		As entered in DocMan																																						JIT/POD						Z or Accordian Fold

		(required) Cost Center:		19134		If your Business Unit is Marketing Commercial, add the appropriate division name after 19134 using the chart on the right. 
All other Business Units: Enter only the number as in DocMan, no description. 
Example - 19021		19134 - Commerc        19134 - OEM 
19134 - Compone        19134 - Power C
19134 - Global             19134 - Process      
19134 - IA                     19134 - Service 
19134 - IMC                  19134 - Safety       
19134 - Industr             19134 - Softwar
19134 - Mkt Dig            19134 - US Marke																																				D1						Microfold or French Fold - designate no. of folds in Comments - intended for single sheet only to be put in box for manufacturing

		Comments:		Spine attached; not included in page count above.																																								D2						Double Gate

						Folds
Half, V, Single                 C or Tri




Dble Parll




Z or Accordian                       Microfold or French





Double Gate

 


Short Fold		Saddle-Stitch Items 
All page quantities must be divisible by 4.
Note: Stitching is implied for Saddle-Stitch -
no need to specify in Stitching Location.
80 pgs max. on 20# (text and cover)
76 pgs max. on 20# (text) and 24# (cover)
72 pgs max. on 24# (text and cover)

Perfect Bound Items
940 pgs max. w/cover (90# index unless indicated otherwise)
70 pgs. min. for spine without words
200 pgs min. for spine with words 

Plastcoil Bound Items
530 pgs max. of 20# (if adding cover deduct equivalent number of pages to equal cover thickness) (90# index unless indicated otherwise)

Tape Bound Items
250 pgs max. on 20# no cover
240 pgs max. w/cover (90# index unless indicated otherwise)																																				D3

																																												D4

																																												D5

																																												D6

																																												D7

																																												D8

																																												D9
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